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Chapter 1

CADENCE designverktyg

1.1 Introduktion

Den här manualen är avsedd som en introduktion till Cadence och som en samman-
fattning av den arbetsmetodik som krävs vid utveckling av kretsar i Cadence-miljö.

Manualen, som behandlar Cadence version 4.42, kommer att ge en överblick över
programvaran och förhoppningsvisockså vara en hjälp i arbetet att utveckla analoga
IC-konstruktioner inom ramen för Cadence.

Cadence programpaket är uppbyggtav många applikationer för varierande uppgifter
som tex schemaritning, layout, kompaktering och verifikation. Dessa applikationer
kan användas på många olika datorsystem. Cadence öppna arkitektur tillåter också
integration av egna verktyg och även verktyg från andra tillverkare. I en sådan
uppställning är det viktigt att verktyg och data blir ordentligt integrerade. Inom
Cadence är det applikationenDesign Framework II(DFW) som säkerställer inte-
grationen.

DFW-programvaran utgör grundstenen i Cadence designmiljö. Applikationen er-
bjuder ett gemensamt användargränssnitt, gemensamma användarfunktioner och
en gemensam databas för all programvara till de verktyg som används. Allt detta
tillåter växling mellan olika verktyg utan konvertering av data till olika format.

Kapitlet ger en generell bild av användargränssnittet som DFW tillhandahåller. Det
behandlar också en del av de verktyg som är integrerade i Cadence programvara.

1.2 Cadence användargränssnitt

Cadence mjukvara har ett grafiskt gränssnitt baserat på fönster, formulär och menyer.
I DFW sker det mesta arbetet i följande fönster:

1



2 CHAPTER 1. CADENCE DESIGNVERKTYG

� Command Interpreter Window(CIW) har kontrollenunder konstruktionsses-
sionen. Information och utdata från de flesta funktioner är synliga i CIW.

� Library Managervisar en trädstruktur med namnen på de bibliotek med
olika konstruktioner som kan användas till designarbetet.

� Design Window(DW) visar den design som är i bruk. Man kan ha flera DW
öppna samtidigt, med olika eller gemensamma verktyg.

� Text Window(TW) visar textfiler. Det går också att ha flera TW öppna sam-
tidigt. En del TW uppdaterar sig själva medan de visar data från en pågående
process. Andra kan ha en enkel texteditor.

Menyerna i Cadence är huvudsakligen avpull-downtyp. Hela menyn dyker upp
(oftast under titelraden) när man väljer en titel. Det finns ävenpop-upmenyer som
visar sig när man trycker ner den mellersta musknappen i fönstrets designarea.

Formulären är till för att kunna ta emot den specifika information som en funktion
måste ha för att kunna exekvera. Det finns tre typer av formulär:standard, option
(ytterligare valmöjligheter) ochproperties(egenskaper).

1.3 Konstruktionsprocessen

Cadence designverktyg har ett gemensamt sätt att organisera och arbeta med kon-
struktionsdata. Man använder sig av bibliotek, cellvyer, instanser och en hierarkisk
uppbyggnad av konstruktionen.

1.3.1 Bibliotek, cellvyer och versioner

Alla konstruktioner i Cadence organiseras i bibliotek.Reference library(refer-
erensbiblioteket) innehåller grundläggande byggblock som kan inkluderas i desig-
nen. Design library(designbiblioteket) innehåller det pågående konstruktionsar-
betet.

Varje bibliotek består av celler, vyer och cellvyer, se figur 1.1. Encell, tex en
inverterare, är ett databasobjekt som formar ett grundläggande byggblock. Envy,
såsom ett schema, är ett sätt att representera objektet på skärmen. Designen som
man ser är encellvy- en unik kombination av en specifik vy av en specifik cell.

1.3.2 Instanser och hierarki

Man börjar konstruktionsarbetetmed att inkluderavirtual copies(representationer)
avmaster cells(originalceller) från referensbiblioteket eller från designbiblioteket.
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Figure 1.1: En inverterarcell med dess olika vyer: layout, schema och symbol.

Därefter kopplar man ihop, lägger till eller modifierar cellerna. Den virtuella
kopian av mastercellen, som är inkluderad i designcellen, kallasinstance(instans).

Allt eftersom en design byggs upp, genom att enkla instanser inkluderas med
mera komplexa, skapas en hierarki med multipla nivåer. Man kan röra sig mel-
lan nivåerna och man kan arbeta på valfri nivå. När man öppnar en konstruktion
erhålls den översta nivån, om inget annat anges.

1.3.3 Teknologifilen

Information som påverkar all design i ett bibliotek lagras i filer som är separerade
från själva designen. Dessa filer är kända somteknologifiler. Varje gång man öpp-
nar ett designbibliotek, så öppnas samtidigt även den teknologifil som är associerad
till biblioteket.

Teknologifilen kan innehålla information om saker som:

� vyer och deras egenskaper

� display-enheter (såsom skärmen)

� färger och punktmönster för displayen

� de olika lager som används under konstruerandet

� konstruktionsregler

� andra egenskaper som är specifika för applikationen.
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1.3.4 Programmeringsspråket SKILL

Då man utför ett kommando från ett formulär eller en menu, så kallar systemet
på funktioner skrivna i språket SKILL. SKILL är utvecklat av Cadence och har
språket LISP som förebild. Cadence programvara använder sig av SKILL för intern
kommunikation, och för kommunikationen mellan verktyg och design.

SKILL är också tillgängligt för användarna. Kommandon kan skrivas in i kom-
mandoraden i CIW eller placeras i olika filer. Man kan använda SKILL för enkla
uppgifter som att exekvera ett kommando, eller bygga upp komplexa rutiner för att
skräddarsy det egna systemet efter givna specifikationer.

1.3.5 Konstruktionsflöde

Flödesscemat i figur 1.2 visar en summering av de steg som genomlöps vid fram-
tagning av integrerade kretsar med stöd av Cadence.

Skapa designen

Analysera designen

Gör en layout för designen

Verifiera designen

Figure 1.2: Flödet för utveckling av integrerade kretsar med hjälp av Cadence
programvara.

Att skapa designeninnebär att skapa schemavyer av alla ingående celler, block och
sub-block. De i sin tur måste ha en symbolvy för att kunna inkluderas i ovanlig-
gande nivåer.

Steget kallatanalysera designenomfattar simulering av kretsen på schemanivå.
Den simulerade kretsen analyseras med avseende på krav relaterade till konstruk-
tionsmetodik och den filosofi som ligger till grund för aktuell kretslösning.

Steg tre,gör en layout för kretsen, utförs genom att implementera layouter för in-
gående byggblock. På de högre nivåerna i konstruktionshierarkin tillämpas floor-
plan samt place och route.

Det sista momentet är attverifiera designen. Layouten undersöks för att eliminera
brott mot geometriska regler, för att hitta eventuella brott mot elektriska regler och
för att verifera funktionen hos den fysiska implementeringen.
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Som det framgår av flödesschemat är processen iterativ. Genom att använda sig av
rätt verktyg på rätt sätt kan utvecklandet rationaliseras och effektiviseras samtidigt
som alla krav kan tillgodoses.

1.4 Schema- och symbolverktyg

Som konstruktör skapar man ett schema av en cell eller en modul och simulerar
schemat för att verifiera funktionen hos den utvecklade kretsen. Detta schema lig-
ger som bas för det efterföljande layoutarbetet. Layouten används i sin tur till
att producera ett fysiskt chip eller ett kretskort (PCB, printed circuit board). Pro-
gramvaran som understödjer schema- och symbol-generering kallasDesign Entry.
Design Entry är ett system med vars hjälp man skapar schemat till en elektronisk
krets.

Det grundläggande verktyget i schema-framtagningsprocessen är schemaeditorn.
Editorn är ett interaktivt system för inmatning av data och uppgifter om konstruk-
tionen. Den är optimerad för att skapa schematiska diagram över elektroniska kret-
sar. Man kan editera objekt som representerar olika delar av designen, som kom-
ponenter, anslutningar eller ledningar vilka etablerar kontakten mellan de olika
objekten. Det är även möjligt att editera objekt vars uppgift är att möjliggöra doku-
mentation, tex text och kommentarer.

Cadence Design Entry erbjuder följande fördelar:

� Under framtagningsprocessen behöver man inte lämna schemamiljön. Ca-
dence system integrerar alla verktyg. Verktygen delar samma databas och
samma gränssnitt som programvaran hos Design Framework II.

� Den schematiska editorn håller reda på alla förbindelser både mellan olika
scheman och genom konstruktionshierarkin.

� Editorn skapar symboler automatiskt och hanterar komponentbiblioteket un-
der arbetets gång.

1.5 Simuleringsverktyg

Simuleringsarbetet sker inuti en domän tillhörande ett system kallatAnalog Artist.
När man tar fram schemat till en krets kan man inkludera olika matningskällor,
kretsvariabler eller komponentekvationer direkt i schemat. Förfarandet innebär att
det tidskrävande arbetet med att manuellt göra nätlistor elimineras. Detta gör att
det interaktiva simulerandet fortlöper i snabb takt eftersom det är mycket lätt att
variera de olika parametrarna som simuleringsarbetet kräver. Det går att snabbt
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ange, byta, analysera, visa och manipulera simuleringsresultat. Till exempel, efter
att ha startat en simulering går det att avbryta den, gå igenom olika noder för att
undersöka spänningen och därefter fortsätta simuleringen.

I centrum av Analog Artist finns Cadence SPICE-simulator, som är en utökad ver-
sion av SPICE frånUniversity of California, Berkeley. Cadence SPICE har en
modifierad arkitektur som tillåter effektiva operationer i olika interaktiva situa-
tioner, som simuleringsstoppoch återstart eller en snabb uppdatering av parametrar
och en ny simulering.

En färdig simulering kan sparas och återskapas för framtida analyser som ett led
för att spara på värdefull utvecklingstid.

Som hjälpmedel för att analysera simuleringsresultatet har Analog Artist utrustats
med verktyg för analys av kurvformer. Verktygen tillåter automatisk mätning av
fördröjningstid, stigtid, översläng, insvängningstid, slew rate, fas och förstärkn-
ingsmarginal, och andra analoga egenskaper som är vanligt förekommande.

En inbyggd vågformskalkylator erbjuder analys av algebraiska uttryck där indata
utgörs av kombinationer av in- eller utsignaler. Sådana uttryck kan plottas som
funktion av vilken ingående variabel som helst, eller ett annat algebraiskt uttryck.

1.6 Layoutverktyg

VirtuosoLayout Editoranvänds för att göra en layout. En layout skapar man genom
att rita rektanglar i olika lager med varierande egenskaper. Det är även möjligt att
inkludera färdiga layoutceller som instanser.

För att verifiera layouten med avseende på geometriska och elektriska konstruk-
tionsregler kan man använda sig avDiva programvara inifrån layout-editorn. Diva
är en mängd verifikationsverktyg med vars hjälp man kan leta upp och korrigera
fel. Diva använder sig av layoutdata för att bl.a. undersöka den fysiska designen
och den elektriska funktionen. Programvaran utför också en kontroll av layout
gentemot schema.

1.7 Place- och Route-verktyg

Inom ramen för Cadence programvara har man tillgång till ett flertal sofistikerade
och kraftfulla place- och route-verktyg. Vilket verktyg som skall användas beror
helt och hållet på vilken konstruktionsmetodik man utgår ifrån. Ett av dessa flexi-
bla floorplan-verktyg kallasPreview. Det erbjuder att man undersöker tidsbegrän-
sningar (timing), möjligheten till sammankoppling mellan blocken (routability)
och andra konstruktionsaspekter i den logiska designen, innan man implementerar
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den fysiska layouten. Man kan även koppla in signaler och analyseratimingoch an-
dra restriktioner under floorplan-arbetet för att ha en bättre kontroll av utplacering
och sammankoppling av blocken. Dessa möjligheter erbjuds för att den kompletta
kretsen skall uppfylla alla krav på storlek och prestanda.

Previews förmåga att strukturera hierarkin tillåter att man kan välja ut den design-
metod som bäst motsvarar den givna konstruktionstekniken och de givna kraven.
Man kan se effekterna på den fysiska layouten innan konstruktionen genomgår den
rigorösa och iterativa place- och route-processen (P&R). Sålunda kan man min-
imera antalet P&R-iterationer och utveckla kretsarna mycket snabbare.

Efter att planerat och optimerat layoutens struktur, kan man köra någon av nedanstående
Preview P&R-produkter:

� Gate Ensamble

� Cell Ensamble

� Cell3 Ensamble

� Block Ensamble

En grov jämförelse ger attGate Ensambleanvänds vid konstruktion med grind-
matriser,Cell Ensambleanvänds vid arbete med standardceller som ansluts med
två lager, medanCell3 Ensambleär till för standardceller med mer än två anslut-
ningslager.Block Ensamble(BE) placerar och sammankopplar inhomogena rek-
tangulära block som avslutning på konstruktionsprocessen.

Routern i BE är utrustad med en sofistikerad kompaktor, vilket innebär ett verktyg
som trycker ihop layouten i både höjd- och sidled. Momentet tar bort tomma ytor
mellan ledare och ingående block utan att inskränka på de geometriska konstruk-
tionsreglerna eller på de olika anslutningsvägarna.

BE utför all typ av routing som krävs för en färdig krets och erbjuder även en enkel
symbolisk editering.

BE erbjuder möjlighet att automatisera P&R-processen helt eller delvis. Vill man
hellre kunna påverka och styra varje steg i arbetsflödet interaktivt, så existerar den
möjligheten också. Block Ensamble tillåter att man minimerar storleken, optimerar
prestanda och säkrar att den resulterande integrerade kretsen följer alla logiska och
geometriska konstruktionsregler, på ett väldigt smidigt sätt.



Chapter 2

Gränssnitt mot användaren

I det föregående kapitlet gavs en relativt ytlig beskrivning av Cadence användar-
gränssnitt. Detta kapitel tränger ner lite djupare i strukturen.

För att ha maximalt utbyte av applikationerna är det av vikt att vara väl insatt i
gränsytan som DFW tillhandahåller. Gränsytan består av fönster, menyer, formulär
och boxar.

2.1 Fönster

I Cadence programpaket är fönstren utrustade med en titelrad, en menyrad och en
arbetsyta där design- eller textinformation visas. Ett flertal fönster har också en
statusrad och en promptrad (figur 2.1). Vissa fönster ( tex. CIW ) har även en kom-
mandorad för textinmatning. Många verktyg har även de vanligaste kommandona
på klickbara ikoner längs ena kanten av fönstret.

2.1.1 Titelrad

Titelraden innehåller information om fönstret och om cellen som visas. Där kan
man utläsa vilken typ av fönster det rör sig om, namnet på cellen och vilken vy
som fönstret visar.

2.1.2 Statusrad

I statusraden finns det information om de olika kommandon som exekveras i det
aktuella fönstret. Typen av information varierar från applikation till applikation.
I exemplet (figur 2.1) indikeras att inga objekt är markerade samt att kommandot

8
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Figure 2.1: Ett editeringsfönster med vyn schematic.

Moveär aktivt. På radens högra sida finns det ett identifikationsnummer som är
unikt för varje fönster.

2.1.3 Promptrad

I botten på vissa fönster finns promptraden som ger information om hur man skall
utföra pågående kommando. Vidare kan man utläsa den aktuella funktionen hos
musknapparna, som t.ex. att höger knapp ger rotation med 90 grader vid ett Move-
kommando.

2.1.4 Menyrad

En menyrad består av en eller flera menytitlar. En meny är en lista av samman-
hängande kommandon. Menyerna i Cadence menyrader är av typen pull-down.
Menyn visas endast när man har valt en titel (figur 2.2). Då förekommer den oftast
under titeln.
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Figure 2.2: En menyrad med en pull-down meny.

Ett kommando uppför sig på ett av följande tre sätt:

� När kommandot är ensamt på raden, somMove i figur 2.2, exekveras det
omedelbart.

� Då kommandot är åtföljt av tre punkter (...), somLabel Display... i figur
2.2, bringar det fram ett formulär där man kan komplettera med ytterligare
information innan exekvering sker.

� Om kommandot har en pil (.) efter sig, somPropertiesi figur 2.2, fås vid
val ytterligare en meny där man får välja ett nytt kommando (figur 2.3).

När det finns en förkortning till höger om ett kommando, kan man utföra komman-
dot genom att trycka på motsvarande tangent på tangentbordet.

2.1.5 Pop-Up Meny

I en del fönster kan man välja olika kommandon ur pop-up menyer. De menyerna
kommer fram då man trycker på den mellersta musknappen när markören befinner
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Figure 2.3: En del menyalternativ resulterar i en ny meny.

sig i fönstrets arbetsyta. Kommandona på menyn relateras till den uppgift som
utförs i det aktuella fönstret.

Expand Next Level

Add Cell to Category...

Create Cell Category...

Delete Cell from Category...

Delete Cell Category...

Figure 2.4: Ett exempel på en pop-up meny.

2.1.6 Markör

Markören finns i många olika former men den vanligaste är pilformen. Många
kommandon startas med hjälp av markören. Till exempel drar man ner en meny
genom att placera markören påtiteln och klicka med vänster musknapp.

Ettaktivtfönster tar emot indata. Endastett fönster i taget kan vara aktivt. Markören
avgör vilket fönster som är aktivt. Om markören flyttas till ett fönster blir det fön-
stret aktivt och dess ram byter färg. Ettaktuellt fönstret tar emot resultatet av ett
kommando och det fönstret behöver inte vara aktivt. Det kan finnas flera aktuella
fönster. Om man markerar ett objekt i ett designfönster kan man i vissa fall vara
tvungen att ge indata i CIW för att kommandot skall kunna exekveras. Man ger
information i det aktiva fönstret (CIW) och ser resultatet i det aktuella fönstret
(designfönstret).
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2.1.7 Musen

I stort sett kan alla kommandon och uppgifter inom DFW utföras med musen.
Musens vanligaste funktioner är:

� Klicka, eller att snabbt trycka ner en musknapp och släppa upp den.

� Dubbelklicka, eller att klicka två gånger snabbt.

� Skift-klicka, eller att klicka samtidigt somshift-tangenten hålls nertryckt.

� Hålla, eller att trycka ner en musknapp och hålla den nertryckt.

� Dra, eller att hålla en musknapp nertryckt medan man flyttar på musen.

Vänster musknapp används genomgående till de flesta funktionerna i DFW (figur
2.5).

Val av kommando

Val av option i formulär

Markera objekt i fönster

Kalla fram pop-up menyer

Figure 2.5: Användningsområden för musens knappar.

För att välja ett menykommando, så skall vänster musknapp hållas på titeln i
menyraden. När menyn kommer fram skall musen dras till det önskade komman-
dot och knappen släppas. Man kan även klicka på menytiteln. Då kommer menyn
fram och stannar kvar så att man kan klicka på det önskade kommandot.
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Man använder även vänsterknappen för att markera val i formulär och för att mark-
era objekt i designfönstrets arbetsyta.

För att exekvera kommandon i pop-up menyer skall man placera markören på en
ledig punkt i arbetsytan och hålla mellanknappen. När menyn kommit fram skall
man dra markören till kommandot och släppa knappen.

Musens knappar är tilldelade varierande funktioner av Cadence olika applikationer.
För mer information hänvisas till respektive applikations manual.

2.2 Formulär

Via formulär anges den kompletterande information en del kommandon kräver in-
nan de exekverar. Formuläret kan liknas vid en redan ifylld blankett där man väljer
mellan olika funktioner och parametrar till funktionerna (figur 2.6).

Help

Laser Writer

DefaultsOK Cancel Apply

Specify Plotter

Auto Fit

Rotation

Plot Header

page size W/H

date/time

window

Header Contents library info

legend

page size

user name

magnification

Title Line 1

Title Line 2

Title Line 3

Output File Name

Local Tmp directory

automatic 90none

More Plot OptionsTitelrad

Textarea

Knapprad

Valknapp

Av/på knapp

Cykliskt fält

Fältnamn

Figure 2.6: Ett exempel på ett formulär.

Formulärets huvud är sammansatt av en titelrad och en rad med knappar. Krop-
pen innehåller olika fält med valmöjligheter. Bredvid fältnamnet hittas något av
följande:

� Ett cykliskt fält för att välja en av ett flertal optioner. Först är bara en option
synlig men om markören flyttas till fältet och vänster musknapp hålls nere
kommer resten av valmöjligheterna att synas i det cykliska fältet.
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� Av/på knappar för att markera om en option skall vara aktiv eller ej.

� Valknappar för att välja mellan ett fåtal valmöjligheter.

� Textarea för att kunna skriva in olka typer av väsentlig information.

Formuläret kan också ha knappar med namnBrowse, som öppnar ettbrowse-
fönster, ellerMore Options, som skapar ytterligare ett formulär.

När ett fält inte kan modifieras skrivs fältnamnet ut med grått istället för svart och
textarean skuggas. Det är inte heller möjligt att skriva något i textarean.

Som tidigare nämnts arbetar DFW med tre typer av formulär,standard, optionoch
properties.

2.2.1 Standard

Standardformuläret dyker upp när man väljer ett menykommando som är åtföljt av
tre punkter. Formulärets knapprad kan beskådas i figur 2.7.

OK Cancel Defaults Apply Help

och tar bort formuläret.

Tar bort formuläret

utan att exekvera

kommandot.

för formulärets olika

Exekverar kommandot

och låter formuläret vara

kvar på skärmen.

Erbjuder information

om kommandot

Exekverar kommandot

optioner.

Visar defaultvärden

Figure 2.7: Knappraden i ett standardformulär.

2.2.2 Options

Ett optionsformulär erbjuder en möjlighet att ändra på gjorda inställningar under
arbetets gång. Det kommer fram medan man utför en uppgift i ett fönster och väljer
ett kommando som har optioner. Ett exempel på knapparna som finns i formulärets
huvud visas i figur 2.8.

Vissa optioner har också enApply-knapp. Den exekverar kommandot men låter
formuläret vara kvar på skärmen.
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Tar bort formuläret

utan att exekvera

kommandot.

för formulärets olika

Erbjuder information

om kommandot

optioner.

Cancel Defaults HelpHide Last

Tar bort formuläret

och låter arbetet

fortskrida.

Visar värden från

det senaste tillfället

då kommandot användes.

Visar defaultvärden

Figure 2.8: Knappraden i ett optionsformulär.

2.2.3 Properties

När man väljerPropertiesi en meny erhålls ett formulär med en knapprad enligt
figur 2.9.

Cadence databasobjekt har attribut och egenskaper. Attributen är en inbyggd del
av ett objekt och kan inte läggas till eller tas bort men dess värden kan ändras.
Egenskaper kan däremot läggas till samt tas bort eller modifieras. Både attribut
och egenskaper är synliga när formuläret är framme.

Figur 2.9 visar utseendet av ett propertiesformulär för ett designobjekt, i detta fall
en utgång med namnetaus.

Figure 2.9: Utseendet av ett properties-formulär.
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2.3 Verktygsboxar

Verktygsboxar är fönster som till största delen eller helt och hållet består av knap-
par. Knapparna startar vissa funktioner. De kan också öppna formulär, fönster
eller andra verktygsboxar (figur 2.10). Den stora fördelen med verktygsboxar är
att om man behöver utföra ett flertal snarlika uppgifter samtidigt, kan man lätt och
behändigt välja mellan de olika kommandona inne i verktygsboxen, istället för att
behöva leta upp dem i olika menyer.

Varje verktygsbox har en menyrad med en eller flera pull-down menyer. Verktygs-
boxarna kan lämnas öppna och flyttas runt på skärmen.

Tracing...

Code Browser...

SKILL Profiler...

SKILL Lint...

SKILL Debugger...

Commands Help 6

SKILL Development

Figure 2.10: Ett exempel på hur en verktygsbox kan se ut. Den här boxen innehåller
verktyg för att arbeta med programspråket SKILL.

2.4 Dialogboxar

Under kritiska skeden i vissa uppgifter kan man få dialogboxar. Dialogboxar ger
information, varningar eller gör användaren uppmärksam på vissa händelser. Di-
alogboxar kräver respons och måste kvitteras. I figur 2.11 visas en dialogbox.
Klicka påOK för att kvittera meddelandet, klicka påCancel för att stoppa oper-
ationen som påbörjades innan boxen dök upp, eller klicka påHelp för att erhålla
ytterligare information om meddelandet.

2.5 Listboxar

En del menyval eller formulärknappar kallar fram en listbox. Listboxar visar en
lista bestående av objekt som skall visas eller markeras. En listbox finns till beskå-
dande i figur 2.11.
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OK Cancel Help

!

Error

Please specify a flowchart name CancelOK

view3

view2

view1

default

Restore View

Figure 2.11: Ett exempel på hur en dialogbox (vänster) och en listbox (höger) kan
se ut.

Genom att dubbelklicka på objektet kommer det att markeras. Markering kan även
ske genom att klicka först på objektet och därefter påOK .

Några listboxar tillåter markering av fler än ett objekt. Flytta markören till det
första objektet, håll vänster musknapp och dra musen tills alla önskade objekt är
markerade. För att utöka en mängd gör shift-klick med vänster musknapp på det
sista objektet i den nya mängden som skall inkluderas. För att ta bort ett objekt ur
mängden skall man trycka påControl-tangenten och klicka med vänster musknapp.
Skall flera objekt avmarkeras, tryck påControl, håll ner vänster musknapp och dra
med musen.

När man har markerat de önskade objekten till värdemängden skall man klicka på
OK . Då stängs boxen.

Vill man stänga en box utan att ange värdemängd, klicka påCancel.



Chapter 3

Starta Cadence och sätta upp
bibliotek

Detta kapitel börjar med att beskriva hur man startar och avslutar en session. Därefter
ges en del tips som underlättar arbetet med Cadence. Vissa fönsterkommandon
och hur man markerar objekt, vilket fungerar på samma sätt för flertalet verktyg,
avhandlas också. Kapitlet avslutas med att beskriva bibliotek och celler.

3.1 Starta programvaran

Det finns en rad olika kommandon för att starta programvaran. Skälet till detta är
att startkommandot anger vilka verktyg och tillämpningar som skall användas.

I skrivande stund är det Cadence version 4.4 med cmosprocessen AMS 0.6 um som
är aktuell och för att kunna köra dessa krävs följande kommandon.

source�amslibs/v3.11/ams_setupsom definierar de sökvägar som behövs i sys-
temet.

ams_cds -mode fb -tech cub -tool artistsom genererar ett antal initialiserings-
filer från olika förlagor. Detta behöver bara utföras första gången man startar
verktygen. I fortsättningen räcker det med

ams_cds -mode fbeftersom information om teknologi och valda verktyg då häm-
tas från initialiseringsfilerna.

Om man i stället kör på någon av linjenämndens maskiner skall man utföra kom-
mandotinittde ana99så får man alla definitioner avklarade och en automatisk start
av programmet.

18
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Har man utfört detta på rätt sätt så skall fönstret kallatCommand Interpreter Win-
dow(CIW), figur 3.1, komma fram på skärmen.

Figure 3.1: Command Interpreter Window (CIW) är det överordnande fönstret i
Cadence.

Cadence kommer därefter att läsa in de initialiseringsfiler som krävs för program-
varan. Meddelanden som refererar till denna inläsning kan läsas i CIW.

3.1.1 Notation

Då systemet har startats är det dags att börja utveckla kretsar med hjälp av Cadence.
Den här manualen är ämnad som ett hjälpmedel till utvecklingsarbetet. För att
undvika missuppfattning har en notation enligt nedan följts:

Tools > Floorplan/P&R > Abstract Editor innebär att man ska klicka med vän-
ster musknapp påToolsför att öppna menyn, klicka på nytt påFloorplan/P&R
för att öppna nästa meny osv.

Layout Preparation betecknar namn på formulär eller fält i formulären.

3.1.2 Avsluta en session

Efter att ha jobbat med Cadence en stund kommer man att ha många fönster uppe.
Dessa fönster behöver man inte stänga ett och ett utan det räcker med att i CIW
väljaFile > Exit.

3.1.3 Tips som underlättar arbetet

Ha CIW öppet under arbetets gång och läs alla meddelanden. I CIW kan man
också se vilket kommando som är aktivt för tillfället. Det är lätt att glömma vilket
kommando som är aktiverat i fönstret och det kan resultera i extra arbete. För
att avaktivera ett kommando skall man trycka påEsc-tangenten då markören finns
i arbetsfönstret. Har man använt fel kommando kan detta åtgärdas. Vid sådana
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tillfällen är kommandotEdit > Undo, som finns i arbetsfönstrets menyrad, mycket
användbart. Vill man ta bort allt som gjorts under en ändringssession utför man
Design > Discard Edits.

När man aktiverar ett kommando och därefter markerar ett objekt, är kommandot
aktivt tills man väljer ett nytt, eller tills man avaktiverar det. Om man däremot
markerar objektet först och därefter aktiverar kommandot, utförs kommandot en-
dast en gång.

Skall kommandon som finns i formulär användas många gånger i följd är det bättre
att använda sig avApply än att klicka påOK .

Det kan hända att formulär, och även fönster ibland, inte syns på skärmen när man
har kallat på dem. Den troligaste orsaken till detta brukar vara att de kommer fram
bakomde fönster och formulär som redan finns uppe på skärmen. Felet förekom-
mer inte hos alla fönsterhanteringsprogram.

Vid oklarheter i arbetsgång och vad som skall anges i formulär, använd online-
dokumentationen för att ta reda på ytterligare fakta. Ibland får man meddelandet
att det inte finns någon information tillgänglig on-line. Det kan bero på att det
inte finns någon koppling mellan databasen och formuläret (eller menyn) som man
söker hjälp ifrån. Då skall man gå upp ett steg i strukturen och kalla på hjälp
därifrån. Till exempel, om man söker hjälp i ett formulär och inte får någon skall
man prova med att kalla på hjälp från menyn där det kommando som öppnade
formuläret finns.

Om det inte är möjligt att markera något objekt så skall man se efter om objekttypen
är markerad i den filterfunktion där det anges vilka objekt som kan markeras. Vid
layoutarbete skall man undersöka om det lager objektet är gjort i kan markeras.

3.2 Fönsterkommandon

Menyraden i arbetsfönstret har en del gemensamma menytitlar, oberoende av vilket
verktyg som används. Menytitlarna är:

Tools Innehållet i verktygsmenyn varierar från verktyg till verktyg. Variationen är
också beroende av vilken editor man jobbar med.

Genom att välja ett av verktygen i menyn kommer menyraden att ändras för
att motsvara den applikation som valdes. Kommandona för varje verktyg
finns beskrivna i verktygets manual.

Design I designmenyn finns kommandon för att kunna spara eller ignorera förändring-
ar gjorda i fönstret, förflytta sig i designhierarkin och för att kunna ändra på
display och display-inställningar.
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Window Windowmenyn styr hur man kan ändra på vyn inne i fönstret, dvs zooma
in eller ut, panorera eller rita upp allt på nytt. Man stänger också fönstret
inifrån menyn.

Edit Kommandona i den här menyn tillåter att man flyttar, kopierar, modifierar
och tar bort objekt. Man kan också utföra andra uppgifter såsom ångra ett
kommando eller leta efter objekt med specifika egenskaper.

Add Menyn används då man skall skapa olika objekt, antingen av geometriska
element eller som instanser.

3.3 Markering av objekt

För att kunna utföra en operation på ett objekt måste objektet markeras.Vänster
musknappanvänds för att markera objekt. Markerade objekt ändrar färg för att
kunna skiljas från omarkerade. I schemafönstrets huvud är det angett i statusraden
hur många objekt som är markerade (Sel: 0). Vilka objekt som kan markeras
styr man genom kommandotEdit > Select > Filter i arbetsfönstret. I formuläret
Schematic Selection Optionsanger man vilka objekttyper som skall kunna mark-
eras. Defaultvärdet är alla objekt.

3.3.1 Markera ett objekt

För att markera ett objekt i en cellvy skall man klicka inuti objektet eller på objek-
tets kant.

Om ett objekt är markerat och man vill markera ett annat räcker det med att klicka
på det önskade objektet. Det “gamla” objektet avmarkeras automatiskt.

För att markera ett överlappande objekt, klicka nära eller på kanten av det önskade
objektet. Om fel objekt markeras så klicka åter en gång på samma punkt.

3.3.2 Markera flera objekt

Det finns tre sätt att inkludera objekt i en markerad mängd:

� Tryck påshift-tangenten och klicka samtidigt på objektet som skall mark-
eras.

� Markera alla objekt samtidigt genom att först hålla med musen utanför mäng-
den. Då får man en rektangel vars innehåll kommer att markeras. Genom att
dra med musen ändras rektangelns storlek. När rektangeln är tillräckligt stor
och rymmer alla önskade objekt skall musknappen släppas upp.
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� Tryck påshift-tangenten och markera en mängd enligt föregående punkt för
att inkludera objekten till den redan förvalda mängden.

3.3.3 Markera objekt delvis

Vill man markera delar av objekt skallF4-tangenten tryckas ner. Då möjliggör
man partiell selektion. För att stänga av optionen trycker man påF4-tangenten
igen. När markering skall ske klicka på en kant eller ett hörn.

Instanser kan inte markeras delvis.

Shift-tangenten har samma funktion här som vid markering av hela objekt.

3.3.4 Avmarkering av objekt

Avmarkering av objekt sker genom att klicka på en yta som inte upptas av något
objekt. Då kommer alla markerade objekt att avmarkeras.

Skall bara ett objekt exkluderas från en markerad mängd behöver man trycka ner
Control-tangenten och samtidigt klicka på objektet som skall tas bort.

Då man vill utesluta fler objekt ur den förmarkerade mängden skallControl-tangenten
hållas nertryckt samtidigt som man håller och drar musen så att de oönskade ob-
jekten omsluts av rektangeln.

F4-tangenten för partiellt val har samma funktion här som vid delvis markering av
objekt.

3.4 Bibliotek

Cadence lagrar alla filer som innehåller konstruktionsdata i bibliotek. Ett bibliotek
innehåller information som är specifik för konstruktionsprocessen, som tex till-
gängliga masklager, geometriska regler osv. Informationen kompileras till bib-
lioteket från teknologifilen. För att underlätta hanteringen av de olika biblioteken
med deras filer finns det en bibliotekshanterare tillgänglig.

3.4.1 Bibliotekshanteraren

Då man startar Cadence kommer det automatiskt upp ett fönster med biblioteks-
hanterarenLibrary Manager, figur 3.2. I denna ser man vilka bibliotek som finns
åtkomliga och vad de innehåller. Här kan man pss. som i CIW styra och ställa i
sin biblioteksstruktur genom att ta bort och lägga till bibliotek och cellvyer. Om
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det skulle vara så att bibliotekshanteraren inte startar automatiskt så startas den
behändigt med kommandotTools > Library Manageri CIW.

Figure 3.2: Library Manager

3.4.2 Skapa ett bibliotek

När ett nytt bibliotek skall skapas är proceduren följande:

1. Välj File > New > Library i CIW. Det skall resultera i att formuläretNew
Library kommer fram. Fyll i namnrutan samt väljAttach to an existing
techfile ochNo DM. Klicka därefter påOK .

2. I det nya fönstret som dyker upp förväntas man välja teknologi. Klicka på
TECH_CUQ följt av OK .

3.4.3 Skapa en cellvy

KommandotFile > New > Cellviewger formuläretCreate New File. I detta väl-
jer man namn på cellen och i vilket bibliotek den skall placeras. Vytypen skall
ochså fyllas i och där kan man välja blandschematic, symbol, layout, extracted, ab-
stract, autoLayout, autoAbstract, syExtractedochcompacted. Slutligen anger man
vilket verktyg man vill applicera på cellen ( för en schematic tar manComposer-
Schematic.
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3.4.4 Kopiera celler

Att kopiera celler i Cadence är en enkel procedur.

1. ÖppnaLibrary Manager. Markera biblioteket som cellen ingår i.

2. Håll med den mellersta musknappen på cellnamnet och väljCopyi pop-up
menyn.

3. I formuläretCopy Cell skall destinationsbiblioteket anges iTo Library
Nameoch i To Cell Nameanges namnet på kopian. kopian samma namn
som originalet. Klicka påOK .

Om det bara är en vy som behöver kopieras skall vyn markeras i managern följt av
Copy i popup menyn.

3.4.5 Ta bort ett bibliotek

1. AktiveraLibrary Manager.

2. Peka med markören på biblioteket som skall tas bort. Håll med den mellersta
musknappen och väljDeletei pop-up menyn. Efter att man har verifierat sina
avsikter kommer biblioteket och dess innehåll att tas bort.

3.4.6 Ta bort en cell

Celler tas bort på samma sätt som bibliotek med hjälp av bibliotekshanteraren.
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Schema- och symbolgenerering

I detta kapitel bekantar man sig med arbetsgången vid schema- och symbolge-
nerering med verktyget Composer.

4.1 Skapa ett schema

1. Biblioteket som schemat skall ingå i måste vara skapat. Om inte, skapa
biblioteket enligt avsnitt 3.4.2.

2. Skapa en cell med vynschematic.

4.1.1 Editera ett schema

Snabbaste sättet att börja editera ett schema är att öppna vyn från managern. Ex-
pandera bibliotek och cell så att vynschematicär synlig. Håll mellersta musknap-
pen på vyn och väljOpeni pop-up menyn. Detta skapar ett fönster i editeringsläge
med designen.

Alternativt kan kommandotFile > Openi CIW-fönstret användas.

4.1.2 Placera en instans

Ett schema byggs upp av komponenter och anslutningar mellan dessa. Kompo-
nenterna hämtas som instanser från ett referensbibliotek.

1. Öppna ett editfönster av aktuell cell med vyschematic.

2. Välj Add > Component. Då skall formuläretAdd Component dyka upp på
skärmen.

25
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3. Klicka på Browse i formuläret. Ett nytt formulär med namnetLibrary
Browser tittar fram. I detta kan man välja vilken instans man vill ha. Nam-
nen på det bibliotek och den instans man klickar på i browsern fylls i au-
tomatiskt i respektive fält i formuläret. Formuläret utökas också med fält i
vilka man får ange värden till instansernas parametrar (tex bredd och längd).
I fältet Instance Namekan man namnge de olika instanserna om Cadence
egen numrering upplevs bristfällig. Instansernas orientering i schemat kan
också ändras med knapparnaRotate, Upsidedownoch Sideways. Fyll i
formuläret och ändra orienteringen vid behov.

4. Flytta markören till schemafönstrets arbetsyta. Där kommer man att se hur
instansens kontur är fäst vid markören. Om man inte kan flytta markören
fritt i fönstret så skall funktionengravityundersökas.

Gravity innebär att markören bara kan röra sig på punkterna i ettgrid-mönster.
En grid är ett stödraster vars punktavstånd är grövre än avståndet i det ab-
soluta koordinatsystem som schemat bygger på. VäljDesign > Options >
Editor i schemafönstret och sätt värdet pågravity till none.

Placera instansen på dess plats i schemat och klicka med musen. En ny
instans av samma typ som föregående är nu fäst vid markören. Vill man ha
en annan typ av instans skall instansen markeras i browsern.

5. Upprepa ovanstående förfarande tills alla instanser är utplacerade.

Klicka därefter påCancel i Add Component formuläret eller tryckCTRL-
C i editeringsfönstret.

4.1.3 Ändra, flytta eller ta bort en instans

Ändra

Om man råkade göra något misstag under momentet utplacering av instanser, tex
angav fel parametervärde, kan det åtgärdas enligt följande:

1. Markera instansen.

2. Välj Edit > Properties > Objectsi schemafönstret.

3. Gör ändringarna i formuläretEdit Object Properties och klicka påOK .

Flytta

Vill man istället flytta på instansen, eller ändra på dess orientering, skall man:

1. Markera instansen.
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2. Välj Edit > Movei schemafönstret.

3. Klicka därefter på instansen så följer den sedan med markören. Om man
även vill ändra orienteringen så kan man dubbelklicka på mellersta musknap-
pen så kommer formuläretMove fram. Här finns knapparnaRotate, Upside-
down ellerSidewaysför att ändra instansens orientering.

Om man vill flytta en instans utan att ändra på dess anslutningar kan kommandot
Edit > Stretchanvändas. Kommandot tillämpas på samma sätt somMove.

Ta bort

Att ta bort en instans är analogt med flyttningsförfarandet.

1. Markera instansen.

2. Välj Edit > Deletei schemafönstret.

4.1.4 Placera kontakter i schemat

En kontakt i Cadence kallaspin. In- eller ut-pins identifierar de noder i schemat
som används för att ansluta andra kretsar eller källor. Pins är mycket viktiga när
man skall generera symboler. En symbol representerar en kombination av kompo-
nenter och ledningar. Varje kontakt i en symbol har sin motsvarighet i en I/O-pin
inne i schemat.

En pin skapas och placeras ut på schemat enligt följande:

1. Välj Add > Pin i schemafönstret.

2. EttAdd Pin-formulär kommer upp på skärmen. I fältetDirection skall man
markera vilken typ av kontakt det rör sig om. Om man skall koppla ihop två
pins av samma slag (in eller ut) kommer Cadence att ge en felsignal. För att
kringgå detta skallinputOutput väljas i fältet när det är önskvärt att kort-
sluta pins av samma sort. Skriv in namnet på kontakten iTerminal Names.
Det går att skriva in flera namn i fältet. Det är användbart då man skall plac-
era ut flera pins av samma sort. Namnen skall separeras med mellanslag.

3. Flytta ut markören i schemafönstret. Konturen av en pin skall nu vara synlig
vid markören. Placera ut den på dess plats i schemat och klicka med vänster
musknapp. Nästa pin kommer då att fästas vid markören.

4. Upprepa ovanstående förfarande tills alla pins blivit utplacerade.
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4.1.5 Rita ledningar

Ledningar används för att förbinda instanser (instansernas kontakter).

1. Välj Add > Wire (narrow)i schemafönstret.

2. Klicka med vänster musknapp på ledningens startpunkt. Ena änden av led-
ningen är nu fäst vid startpunkten medan den andra är fäst vid markören

3. Dra markören till slutpunkten. Genom att klicka med vänster musknapp en
gång, antingen på en annan ledning eller en kontakt, placeras ledningen i
schemat.

4. Vill man själv dra ledningen klickar man med vänster musknapp en gång
på en tom yta i schemat för att flytta referenspunkten, som är den punkt
editorn utgår ifrån när den placerar ut ledningen,tills man har erhållit önskad
ledningsdragning.

5. För att avsluta ledningen “i luften” skall man dubbelklicka med vänster
musknapp.

4.1.6 Verifiering av schemat

När man skapat eller editerat ett schema skall det extraheras. Det innebär att
schemat undersöks med avseende på flytande ledningar eller kontakter, kortslut-
ningar osv. Alla fel markeras med en blinkande gul box.

1. Välj Design > Check and Savei schemafönstret. Om det existerar fel kom-
mer en dialogbox som skall kvitteras.

2. För att behandla felsignalerna skallCheck > Find Markersutföras i schemafön-
stret.

3. Ett textfönster som förklarar vad felet är syns på skärmen. Den felaktiga
noden är markerad av ett blinkande kryss. Med knapparnaNext ochPrevi-
ouskan man stega igenom alla felsignaler och avläsa deras typ i textfönstret.
Klicka påCancelför att ta bort formuläret.

4. Felsignalerna avlägsnar man antingen genomCheck > Delete Markers, då
signalen skall markeras, ellerCheck > Delete All Markers. Klicka påOK i
formuläretDelete All Markers.
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4.1.7 Spara schemat

När alla felsignaler är åtgärdade skall schemat sparas. Detta sker i schemafönstret.

1. Utför Design > Check and SaveellerDesign > Save.

2. Om man vill spara schemat under ett annat namn skallDesign > Save As
väljas. I formuläret som dyker upp,Save As, skall man fylla i fälten och
klicka påOK .

4.1.8 Skapa en symbol

Om man vill inkludera cellen i en ovanliggande nivå måste man skapa en symbolvy
åt cellen. Symbolvyn skapar man inifrån schemavyn.

1. Välj Design > Create Cellview > From Cellview. FormuläretCellview
From Cellview skall komma fram på skärmen.

2. I nedersta fältet skall det ståFrom View Name schematic To View Name
symbol

3. FormuläretSymbol Generation Options dyker upp. Här har man möj-
ligheten att ändra på pin-placeringen. Klicka sen påOK .

4. Nu kommer symbolen upp i en editor. Är man inte nöjd med utseendet så
kan man rita om den. Det gröna i figuren är vad man ser då man använder
symbolen i ett schema och den röda ramen bör innesluta allt.

4.2 Utskrift av schema

Om man vill ha en utskrift av schemavyn skall nedanstående förfarande följas:

1. Öppna ett schemafönster som visar schemat av intresse.

2. Välj Design > Plot > Submitfrån menyraden. FormuläretSubmit Plot kom-
mer fram. I detta skall man lämpligen avmarkeraPlot With Header och sen
klicka påPlot Options.

3. Ett nytt formulär,Set Plot Options, dyker upp på skärmen. Här kan man
ange ett antal olika optioner som vilkenprinter det skall skrivas ut på, eventuell
skalning osv.

Eftersom institutionens printrar inte är åtkomliga från efd domänen så kan
man välja att skriva ut till en postscriptfil istället. Denna kan sedan skickas
till en printer för utskrift.
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Simulering av krets i Cadence

Kapitlet börjar med att beskriva hur en simulering skall utföras och avslutas med
att berätta om de verktyg som finns för analys av simuleringsresultatet.

5.1 Förberedelse av schemat

Simulering i Analog Artist simuleringsmiljö sker via ett simuleringsfönster. I fön-
stret styr man alla moment interaktivt genom det grafiska gränssnittet. Men innan
själva simulerandet börjar måste schemat som skall simuleras förberedas, så att det
innehåller alla väsentliga komponenter.

Förutom att kunna gå igenom extraheringen utan några fel behöver schemat också
kompletteras med ström- eller spänningskällor till simuleringen. Eventuellt måste
även laster av olika slag läggas till.

Ett bra sätt att strukturera simuleringen på är att göra en symbol av schemat och
inkludera det i en ovanliggande nivå där källor och laster kommer att finnas. Detta
är praktiskt om schemat refereras av högre nivåer. Då slipper man ta bort källor
och laster innan schemat inkluderas i designhierarkin, och om man måste upprepa
simuleringarna slipper man lägga till komponenterna igen.

Skapa därför en schemavy av en cell, där kretsen som skall simuleras inkluderas
som en instans. Förutom kretsen måste man lägga till källor och eventuella laster.
Dessa instanser tas ur ett referensbibliotek.

30
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5.2 Starta simuleringsmiljön

Utför kommandotTools > Analog Artisti ett edit-fönster med schemavy. Detta bör
medföra att fönstretAnalog Artist Simulation (figur 5.1) visar sig.

Figure 5.1: Kontrollfönstret för Analog Artist.

Redan vid uppstart står här vilken cell man tänkt sig att simulera samt i statusraden,
vald simulator. Om den senare inte ärspectreSkan man ändra under menynSetup.
Kommandona i menyn hjälper till att sätta upp variablerna för simuleringsmiljön,
t.ex. sökvägen till modellbiblioteket, namn på externa styrfiler, namn på initier-
ingsfiler eller typen av nätlistor.

Temporära filer som behövs under simuleringen lagras i directoryt./Simsom alltså
ligger i ens eget filträd. Vid större simuleringar kan detta bli ohemult stort och få
hela miljön att hänga sig. Då kan man ändra vidProject Directory underSetup >
Simulator/Directory/Host( t.ex. till /tmp/agurk ). Glöm bara inte att ta bort detta
efteråt.

I Analysisspecificerar man vilken typ av analys som önskas, t.ex DC, AC, transient
eller brus.

UnderVariablesmenyn sker också handhavandet av variabler för simuleringsar-
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betet. Man behöver inte ange absoluta värden till de olika komponenternas parame-
trar utan en variabel kan anges istället. Variabeln i sin tur tilldelas värden av kom-
mandon som finns i denna meny.

Vilka noder som skall analyseras och hur man skall presentera datamängden från
analysen anges underOutputs. Data kan observeras interaktivt under simuleringen
eller sparas på fil för att behandlas efter simuleringen.

De viktigaste kommandona iSimulateär RunochStop. I menyn specificerar man
också värden på vissa parametrar för att simulatorn skall uppnå konvergens.

Menyn kalladResultsstyr all databehandling efter simulering. Menyn används till
att välja ut vilka resultat som skall analyseras. Resultaten visas och behandlas i ett
vågformsfönster.

I Toolsfinns det möjlighet att utföra enParametric Analysis. En parametrisk analys
innebär att man undersöker kopplingens uppförande med avseende på en parame-
ter, vars värde varieras inom ett intervall. Parametern sveps inom intervallet med
en specifik steglängd och hela den iterativa svep-processen räknas som en analys.

5.2.1 Välja typ av analys

1. Välj Analysis > Choose...i simuleringsfönstret. FormuläretChoosing Anal-
ysesskall då visa sig på skärmen.

2. Fyll i formuläret enligt givna krav på analysens art. AnvändOptions. Klicka
påOK .

5.2.2 Markera noder vars simuleringsdata skall visas

Det finns som sagt två sätt att presentera data från simuleringen. Första sättet är att
data skrivs ut kontinuerligt under simuleringen. Detta sätt är lämpligt att använda
sig av när det rör sig om korta och snabba simuleringar. Nackdelen är att man inte
kan utföra operationer som zooma in eller läsa av vissa punkter. Fönstret är enbart
till för att visa signalerna.

Skall man däremot simulera en komplex krets är det lämpligare att lagra simuler-
ingsdata på en fil och presentera informationen när simuleringen är avklarad. Det
blir en betydande tidsvinst jämfört med kontinuerlig utskrift av data. Till skillnad
från det förra sättet kan man även utföra operationer på kurvorna i det grafiska
fönster som presentationen sker i.

Det går bra att kombinera båda metoderna under en simulering.

Markering av nod kan även ske på nivåer som ligger under den nivå där man startat
simuleringen.
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Det finns möjlighet att spara den nodkonfiguration som markerats. Vid nästa simu-
leringsomgång slipper man ange noderna på nytt och det räcker med att ladda in
filen som innehåller den aktuella nodkonfigurationen. Har man många noder som
skall analyseras är det en fördel att spara konfigurationen på fil om data skall anal-
yseras efter simuleringen. Då skall man ange vilka noder som skall presenteras
grafiskt. Genom att använda sig av en konfigurationsfil går arbetet snabbare och
smidigare.

Kontinuerlig utskrift av simuleringsdata

1. Välj Outputs > To Be Marched > Select On Schematici simuleringsfönstret.

2. Nu förväntas man peka på de noder, vars värden man vill följa, med markören
( och klicka ). Om det är strömmen man är intresserad av måste man markera
en instansterminal (den röda kontaktboxen). Om det istället vill ha spännin-
gen så väljer man en bit leding. Man kan se vilka som väljs i simulerings-
fönstret under rubriken Outputs.

3. De valda värde kommer att presenteras löpande under simuleringens gång i
fönstretMarching Waveform Window .

Simuleringsdata på fil

Välj Outputs > To Be Saved > Select On Schematic. Därefter markeras intressanta
noder pss. som tidigare i schemat. Man kan också välja...To Be Plotted...så
kommer man automatisk att få upp ettWaveform Window, med värdena plottade,
efter simuleringen.

Markering av noder på lägre nivå i hierarkin

Välj Design > Hierarchy > Descend Editi schemafönstret. Klicka påOK och
välj därefter instansen i vilken den sökta noden ingår. Detta förfarande upprepas
tills man når önskad nivå. När man skall tillbaks till den ursprungliga nivån väljs
Design > Hierarchy > Return to Topi schemafönstret.

Nodkonfiguration på fil

Om man vill spara hela eller delar av sin setup så använder man med fördel kom-
mandotSession > Save State...så erhålles ett fönster i vilket man kan välja vad
man vill spara samt ett namn till vilket man kopplar det sparade tillståndet, det är
alltsåinte ett filnamn det rör sig om.
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5.2.3 Ta bort en markerad nod

För att ta bort en markerad nod kan man antingen välja den på nytt i schemat, eller
användaOutputs > Setupsom ger ett formulär där man kan markera och ta bort
noder.

5.2.4 Starta simuleringen

Simuleringen startas med kommandotSimulation > Runi simuleringsfönstret. När
simuleringen är klar hörs det ett pip och man får ett fönster med de önskade våg-
formerna under förutsättning att man valde...To Be Plotted...för mätpunkterna. I
simuleringsfönstret syns även olika meddelanden från simulatorn.

Vill man avbryta simuleringen görs det medSimulation > Stop. Det är inte möjligt
att återuppta en stoppad simulering, utan man måste börja om från början igen.

Om man valde att visa simuleringsdata kontinuerligt under simuleringen kommer
man att få ett fönster kallatMarching Waveform Window . I det fönstret presen-
teras data grafiskt allteftersom simulatorn räknar ut dem.

5.2.5 Fel vid simuleringen

När simuleringen av någon anledning misslyckats får man med hjälp av medde-
landena i simuleringsfönstret lokalisera felkällan och åtgärda felet. Om den er-
hållna informationen inte är tillräcklig kan man titta i simulatorfönstrets egen logfil
som är åtkomlig med kommandotSimulation > Output Log .

5.2.6 Analys med variabler

En komponentparameter kan tilldelas en variabel istället för ett absolut värde. En
variabel är en textsträng som representerar ett absolut värde. Genom att utnyttja
variabler kan simulerandet göras effektivare och snabbare. Man behöver t.ex. inte
spara schemat efter varje parameterändring utan simuleringsarbetet kan fortskrida
direkt. Att jobba med variabler förutsätter att man har valt typ av analys och mark-
erat de noder vars värden man är intresserad av.

1. Man lägger in variabler i sitt schema mha. kommandotEdit > Properties >
Objects, väljer önskad komponent och skriver ett variabelnamn istället för
ett absolut värde på en komponentparameter.

2. Utför Variables > Editi simuleringsfönstret. Formuläret kallatEdit Design
Variables skall synas.
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3. I det formuläret börjar man med att väljaCopy From. Det skall medföra att
de variabler som finns specificerade i schemat läses in.

4. Nu kan man välja och modifiera värden på sina variabler. Därefter kan man
enkelt starta en simulering med de nya värdena genom att klicka påApply
& Run Simulation .

5.2.7 Parametrisk analys

Vid en parametrisk analys representeras den aktuella parametern av en variabel vars
värde kommer att svepas inom ett intervall. Förfarandet kan sägas vara en variant
av analys med variabler där man “automatiserat” momentet att tilldela variabeln
nytt värde. Även här förutsätts att man har markerat noder för presentation av
data. AlternativetMarchkan inte tillämpas. Innan man börjar utföra nedanstående
punkter skall man också har angett vilken typ av analys som skall utföras.

1. Tilldela en komponentparameter ett variabelnamn enligt ovan.

2. Utför Tools > Parametric Analysisi simuleringsfönstret. Ett fönster som
kallasAnalog Artist Parametric Analysis (PA) skall synas på skärmen.

3. I fältetVariable Name fyller man i önskat variabelnamn.

4. I fältetRange Typeväljer man ett intervall, inom vilket variabelvärdet skall
svepas. Det finns tre alternativ:

From/To innebär ett intervall mellan två olika punkter.

Center/Span innebär att intervallet ges av den absoluta avvikelsen från en
mittpunkt.

Center/Span% innebär att intervallet ges av den relativa avvikelsen från
mittpunkt.

Fälten där man anger data för intervallet kommer att ändra sig efter den typ
av intervall som väljs.

5. I fältetStep Control anger man hur svepet skall delas upp i intervall. I läge
Auto delas svepet upp i fem lika stora delar. Om skillnaden mellan start- och
slutpunkt är större än 10 kommer systemet att begagna sig av logaritmiska
steglängder. Det rekommenderade läget ärLinear Steps, vilket delar upp
svepet i intervall med en steglängd som man anger i ett av datafälten.

6. När man har valt intervall och steglängd skall simuleringen startas. Det görs
genom kommandotAnalysis > Starti PA.

7. Resultatet kan analyseras i ett vågformsfönster.
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8. När den parametriska analysen är färdig och man har studerat resultatet
stänger man fönstret genomTool > Closei PA.

5.3 Stänga av simuleringsmiljön

När alla simuleringar och analyser har utförts stänger man av simulatorn med kom-
mandotSession > Quiti simuleringsfönstret.

5.4 Analys av simuleringen

För att kunna utföra en realistisk analys av simuleringen behöver man ha tillgång
till arbetspunkterna hos de olika instanserna. Datamängden som simulatorn räknat
fram skall även vara presenterad på ett överskådligt och lättläst sätt. Arbetspunk-
terna presenteras i ett textfönster medan övriga analysdata presenteras grafiskt i ett
vågformsfönster.

Man kan välja mellan att addera en plot från en simulering till den eller de kurvor
som redan finns i ett uppstartat vågformsfönster, eller att låta varje ny plot ritas
upp för sig själv i vågformsfönstret, dvs radera ut redan befintliga plottar. Om det
senare alternativet önskas, skall man väljaResults > Plotting Optionsi simuler-
ingsfönstret. I formuläretSetting Plotting Optionsskall man då markeraOverlay
Plotsoch klicka påOK .

5.5 Arbetspunkter

1. Utför Results > Printi simuleringsfönstret. I menyn kan man välja mellan
olika arbetspunkter och parametrar. Välj önskad option.

2. Markera instans eller nät som skall undersökas genom att klicka i schemafön-
stret.

3. Ett textfönster med önskad information erhålls. Fönstret har en sökfunktion
som är användbar när det är mycket data som visas. Kommandot ärFile >
Search. Fyll i formuläret enligt önskemål.

5.6 Vågformsfönster

Innan kurvorna ritas upp måste man välja vilka noder som skall presenteras. Välj
Outputs > To Be Plotted > Select On Schematic. Markera noderna enligt tidigare
förfarande.
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Välj Results > Plot Outputs > .....i simuleringsfönstret. Punkterna står för den
typ av analys som är aktuell (Transient, AC, DCeller Noise). Ett vågformsfönster
(Waveform Window) skall då visa sig på skärmen.

Kommandona i vågformsfönstrets menyrad hjälper till att visa och manipulera
simuleringsresultatet. Menykommandona är grupperade enligt den objekttyp som
de kan appliceras på.

5.6.1 Diagram

En eller flera kurvor i ett diagram

När fönstret kommer fram visas alla kurvor i samma diagram. Vill man ha separ-
erade kurvor skallAxes > To Stripväljas. För att återgå väljAxes > To Composite.

Om man vill att de olika kurvorna (separerade kurvor) skall byta plats i fönstret,
användEdit > Swap Strips. Klicka först på kurvan som skall flyttas och därefter på
kurvan som den skall byta plats med.

Kurvrepresentation

Med kommandotCurves > ....styr man hur kurvan skall representeras. Datapunk-
terna kan visas separerade eller förbundna och man kan också välja med vilken
figur värdet skall visas.

X-Y plot

Vill man ha en X-Y plot skallAxes > X Axisväljas. Det resulterar i ett formulär
med samma namn i vilket man kan modifiera X-axelns utseende. I fältetPlot vs.
väljer man den variabel man vill ha på X-axeln. För att återgå till vanlig plot väljer
manIndependent Variable.

Kurvavläsning

För att avläsa det exakta värdet av en punkt i en kurva skall markören placeras på
den intressanta punkten. X- och Y-koordinaterna kan avläsas i fönstrets övre vän-
stra hörn. Använd kommandona iZoommenyn för att zooma in delar av kurvan.
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5.7 Kurvanalys med vågformskalkylatorn

Med vågformskalkylatorn kan man utföra operationer och analyser direkt på de
olika kurvorna i vågformsfönstret. Kalkylatorn startas med kommandotTools >
Calculatori vågformsfönstrets menyrad.

Kalkylatorn bygger på omvänd polsk notation (reverse polish notation, RPN). En
RPN-kalkylator utför aritmetiska operationer genom att operanderna skrivs in före
operatorn. Om texa ochb skall adderas, skriver man först in de två operanderna
och därefter utförs additionen. Uttrycken som skrivs in lagras i en stack. Lagringen
sker genom att klicka påenter. Stackens fem översta element kan visas genom att
väljaDisplay Stack. Fältet där uttrycken skrivs in i kalkylatorn kallas för buffert.

5.7.1 Ta bort data ur buffert och stack

För att ta bort data ur buffert och stack kan man välja mellan:

backspaceTangenten tar bort ett tecken i taget när man har skrivit fel i bufferten.

clear Genom att klicka på knappen tas uttrycket i bufferten bort, utan att stacken
berörs.

clst Funktionen tar bort allt från buffert och stack.

5.7.2 Mata in uttryck från schemat

Knapparna för att mata in schematiska uttryck till kalkylatorns buffert är:

vt transientspänningar it transientströmmar
vf frekvensspänningar if frekvensströmmar
vs svepspänningar is svepströmmar
vdc DC-spänningar op DC-arbetspunkter
vn brusspänningar opt transientarbetspunkter
var designvariabler mp modellparametrar

Själva inmatningen sker genom att:

1. Klicka på någon av ovan listade knappar.

2. Markera i schemafönstret den nod, terminal, instans eller det nät som är av
intresse. Uttrycket kommer att synas i bufferten, t.ex.IT(“/M1/s”) som
betecknar transientströmmen i source hos transistor M1.
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5.7.3 Utföra kurvanalys

Specialfunktioner

Efter att ha matat in ett uttryck kan man applicera olika kommandon på det. De
kommandon som är av intresse finns i det cykliska fältetSpecial Functions. Fler-
talet av kommandona skall ha intervallgränser. Dessa gränser kan anges som nu-
meriska värden, eller så kan de anges som markeringar (markers) i det diagram
som visar den kurva man vill analysera.

Marker

Utför Markers > Vertical Markeri vågformsfönstret. VäljAdd Graphically i det
formulär som kommer upp och klicka sedan i vågformsfönstret där man vill ha sina
intervallgränser. Man erhåller då vertikala markörer som numreras löpande ( M1,
M2 osv. ). Vill man ta bort markers så görs detta avEdit > Delete. Ett mycket
användbart kommando ärDisplay Intercept Data som resulterar i ett textfönster
med information om de markeringar som finns (tex lutningen för de kurvsegment
som markeringarna avgränsar).

Ange intervallgränser till specialfunktioner

Flertalet av specialfunktionernaresulterar i formulär där man anger intervallgränser,
steglängd eller andra värden av intresse. För att ange direkta värden skally mark-
eras i fältenInitial Value ochFinal Value. Om man använder sig av markers för
att ange intervallgränser skall de skrivas med stort M (t.ex. M1). I det fallet skally
at x vara markerat i fälten som avgränsar intervallet.

1. Välj den funktion som är av intresse i räknarens fältSpecial Functions.

2. Fyll i formuläret som dyker upp och klicka påOK .

3. I bufferten kan man avläsa kommandot man valt och dess parametrar. T.ex.
slewRate(IT("/M1/S"),M1,t,M2,t,10,90), som står för slewrate för transientström-
men i source hos transistor M1. Intervallet är mellan marker M1 och M2.
Värdet beräknas mellan 10- och 90-procentsvärdena.

5.7.4 Visa resultatet av kurvanalysen

För att visa resultatet av valt kommando kan man klicka påprint . Då får man upp
ett textfönster med kommandot som är skrivet i bufferten och dess resultat.
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Man kan även klicka påplot. Då ritas resultatet upp i vågformsfönstret. Resultatet
adderas till befintliga diagram. Vill man att endast resultatet visas i vågformsfön-
stret skall man välja alternativeterplot.

Om man har flera uttryck i stacken kan dessa läggas till uttrycket i bufferten genom
att klicka påapp. Uttrycken kommer att vara separerade av ett mellanslag. För att
visa resultatet, gör enligt ovan.

5.7.5 Text och titel

Man kan skriva textsträngar och lägga in dem på valfri plats i vågformsfönstret.
Det är användbart när man behöver lägga in kommentarer av olika slag. VäljAn-
notation > Edit. Ett formulär kallatAnnotation kommer fram och här kan man
skriva in den text man vill ha samt ange önskad textstorlek, färg etc. Klicka sedan
på knappenAdd och markera i vågformsfönstret var texten skall placeras. Vill man
flytta eller ta bort text sker detta med kommandon underEdit.

Man har också möjlighet att ange en egen titel på fönstret. VäljAnnotation > Title.
Då får man ett litet formulär i vilket man skriver in lämplig titel och gör övriga
val gällande storlek, font, osv. Vill man sedan ändra eller ta bort titeln kan man
dubbelklicka på den så kommer formuläret upp.

5.8 Generering av nätlista

Genom att väljaSimulation > Netlisti simuleringsfönstret genereras en nätlista
som innehåller en beskrivning av schemat. Två val erbjuds:RawochFinal. Raw
genererar en nätlista som endast innehåller komponenterna, medanFinal även
inkluderar alla styrkommandon till simulatorn.

5.9 Utskrift av diagram

Vill man ha en utskrift av diagrammen i fönstret skall man väljaWindow > Hard-
copy. Välj printer och gör eventuella övriga inställningar, se till att avmarkeraPlot
With Header och klicka påOK .



Chapter 6

Building with Layout

This chapter consists of two parts. The first describes the generation of layout
views and the second deals with the different tools used for verifying the layout.

6.1 Creating Layout Views

1. The library in which to place the layout has to exist, if not create it (CIW:File
> New > Library).

2. Create a cell with view namelayout(File > New > Cellview).

6.1.1 Edit a Layout

The fastest way to open an existing layout is to mark it in the Library Manager and
selectOpenin the pop-up menu on the middle mouse button.

6.1.2 Layer and Selection Window

When an edit session starts, an extra window (Layer and Selection Window LSW)
will appear. It shows the various layers available for the selected process.

From LSW one can:

� Select current drawing layer.

� Set which layers to be visible in the layout window.

� Define selectability of layers, instances, and pins.

� Save and load changes of the setup in LSW.

41
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Drawing Layer

The layer visible in the head of LSW is the current drawing layer, i.e. the layer
in which added structures will appear. To change click left on the wanted one in
LSW. The new layer will now be visible in the head.

Layer Visibility

By clicking the middle button on a layer in LSW it will not be drawn in the edit
window. This is marked by greying out the small box. There are also the buttons
NV (None Visible) andAV (All Visible) which affects all the layers.

The changes will not be visible in the working window until it is redrawn (Window
> Redrawor Ctrl-r ).

Selecting structures

All layers, pins, and instances can be selected unless the selectability has been
turned off which is shown by a greying of the name part of the box in LSW.

To disable a layer from beeing selected click right on the representation box in
LSW. The layers can also be controlled withNS (None Selectable) andAS (All
Selectable). Inst andPin controls instances and pins.

6.1.3 Components of a Layout

A layout is composed of rectangles representing different layers with varying char-
acteristics. It is also possible to include other layout cells as instances to get a
hierarchical design. The rectangles are created as below.

1. Select wanted layer in LSW.

2. DoCreate > Rectanglein the edit window.

3. Click left to place one corner of the rectangle att the cursor’s position. The
opposite corner is placed on the next left click. If the cursor cannot move
freely examine thegravity property. SelectDesign > Options > Editorin
the layout window and setgravity to none.

When including instances, do this.

1. Start withCreate > Instance. The formCreate Instancewill appear.
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2. Fill out the form with the wanted instance or use the browser. The fields
Rows, Columns, Delta X andDelta Y are very useful when placing several
identical instances. The buttonsRotate, Sideways, andUpsidedownare
used to change the orientation of the included layout.

There are more interesting commands in theCreate-menu. TryCreate > Path
for example. It is used to draw wires between objects that should be connected.
Always check the prompt-line at the bottom of the window. It gives instructions
of what one is supposed to do next in the current command. Most commands have
a form in which some parameters can be changed. To get this form, doubbleclick
middle or press F3.

To move origo in the layout use the commandMisc > Move Originand place the
crossbar where it should be.

6.1.4 Copying and Moving Objects

Copying

1. SelectEdit > Copy.

2. Mark the object to be copied.

3. The copy will be in the same layer as the original. To change bring out the
form (F3) and click onChange Layerand chose the new layer.

4. Fill out theRows andColumns fields to create a matrix. The elements in
the created matrix will be separated objects.

5. Place the copy by clicking left button on the designed coordinates. The el-
ements of a matrix are placed by first placing one of the elements followed
by the columns and finally the placing of the rows.

Move

1. With the commandEdit > Movethe placement of an object can be changed.

2. Mark the object to be moved.

3. Click left on the new location.

6.1.5 Stretching

1. ChoseEdit > Stretch.
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2. Select the edge on the object(s) that should be stretched.

3. The new location is selected by clicking left when the cursor is in the correct
position.

6.1.6 Hierarchical Connections

The connections between different cells in a hierarchical structure are achieved by
layoutpins, much in the same way as in a schematic. Pins should be placed on the
perifery of the cell and are created in a specific pin-layer which is associated to the
corresponding wire. For example, if the connecting wire is MET1/dg (drawing)
the pin should be in the layer MET1/pn.

1. Mark the layer in which to create the pin and executeCreate > Pin. The form
Create Symbolic Pinappears. In this, change toShape Pinand also click on
Create Label. List the names in theTerminal Namesfield and set the type
wanted inI/O Type. Select the same type and name as in the corresponding
schematic. The type does not matter for the power connections but the name
must end with an exclamation mark (vdd!).

2. The fieldAccess Directioncontains information to the automatic router on
how to connect to this pin. Select the same direction as the edge where the
pin is placed.

3. Draw a box with the left button where the pin should be located and select
where to put the name label. Make sure that the pin is completely covered
by the wire layer. The pin-layer has to respect the same layout rules as the
drawing-layer.

6.2 Verification of a Layout

The verification of the layout is made in two steps. The first,Design Rule Check
(DRC), examines the layout with respect to the geometrical design rules. There-
after it is extracted (i.e. a netlist is created from the layout view) as a preparation
for the second step,Layout Versus Schematic(LVS), which compares the schematic
view with the extracted and reports on differencies.

6.2.1 DRC

A Design Rule Checkchecks that the layout fulfills the geometrical rules for the
different layers of the selected process ( minimum sizes, spacings, etc.) Errors will
be reported and marked to facilitate correction. AnElectrical Rule Check(ERC)
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is also run which checks for electrical errors like short circuit, latch-up, floating
nodes, etc.

1. ChoseVerify > DRCand theDRC-form will appear.

2. The verification can be done in aflat or hierarchical mode. In the former,
all instances will be lifted up to the top level before checking is done. In
thehierarchical mode the DRC will check multiple occurences of the same
instance only once which should speed up the execution time on large con-
structions.

3. With Set Switchesit is possible to set some switches that affect the kind
of checks to be made. It is possible to generate some of the necessary
implant layers by selecting “generate_FIMP” or to ignore its absence with
“no_FIMP”.

4. When the setup is done click onOK to start the DRC.

5. The logging in the CIW will show the errors and they are also marked in the
layout window. They can be studied more closely by the commandVerify >
Markers > Find.

6.2.2 Extraction of a Layout

When the layout fulfills all the layout rules it is ready for extraction. The extracted
netlist will consist of the the different components and how they are connected. It
is also possible to get information of the capacitances on the connecting wires.

1. Start byVerify > Extract.

2. It is possible to do aflat or hierarchical extraction.Full hier will cause the
whole circuit to be extacted whileincremental hier only processes what has
been changed since the last extraction.

3. Select the wanted type and clickOK . The extractor will now create a new
cellview with the same name as the layout but with the view nameextracted.

4. Errors during the extraction phase are treated the same way as errors from
the DRC.

6.2.3 LVS

TheLayout Versus Schematic(LVS) will compare the layout against the extracted
view and report any discrepancies. In order for this to work the pin names of the
schematic and layout views has to be identical.
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Figure 6.1: The form: Layout Versus Schematic (LVS).

1. The LVS is started byVerify > LVS.

2. Fill out the form (figure 6.1) with the names and views to be compared.

3. Make sure that theRules FileandRules Library are filled in correctly and
click onRun.

4. If an LVS check has been performed earlier on another cell the contents
of some setup files will differ from the current form. Then anLVS Form
Contents Different message will appear. Click onForm Contents to chose
what is in the form.

5. After the analysis is done a small box with the messageAnalysis Job Suc-
ceededshows up. This only means that the program has finished and not
that the LVS check was satisfactory.
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6. A click onInfo in theLVS form will produce aRun Information window in
which the results can be viewed. SelectOutput for the log file which should
contain the string “The net-lists match” if all is well.

7. If not, use the buttonError Display to start a simple error handler which
can show and explain what differs.

8. The error handler is closed byCanceland theLVS form is shut down with
Commands > Close Window.

6.3 Post-Layout Simulation

The expressionpost-layout simuleringmeans a simulation of the extracted netlist
with the parasitic components that always exists on the layout. These can have
great impact on the funtion and performance of the circuit regarding delays and
switching times.

To achieve a net list with the parasitics the extractor is used. Thereafter a configura-
tion file is created which describes the design and what components and instances
it contains.

6.3.1 Parasitic Extraction

Start the extraction program as before, 6.2.2. Click onSet Switchesin the form
and selectcapall. The extracted view will now contain the parasitic components.

6.3.2 Generation of the analog_extracted view

Start theLVS and compare the two cellviews with each other as earlier described.
When the are identical click on the buttonBuild Analog and make sure thatenable
all is chosen. This will create a new view with the name analog_extracted with the
parasitics.

6.3.3 The Configuration File

The configuration file is a description of which parts (cells) that builds up the de-
sign. The view to be used, in the simulation, can be selected for each cell. For
time-critical structures the analog_extracted are used and for less important cells it
might be enough to use the schematic view. Use the following procedure to create
the configuration file.
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Figure 6.2: The Hierarchy Editor.

1. In theCIW -window execute the commandFile > New > Cellview. Fill in
the name of the cell and set the view name toconfig.

2. Two form surfaces.Hierarchy Editor and on top of thatNew Hierarchy.
SelectspectreSatBuilt-in in the latter and fill out the data for the cell. The
view should beschematic. OK

3. In the form of theHierarchy Editor (figure 6.2) is a list of the cells of
the construction. By clicking right in the columnView To Usefollowed by
Select > it is possible to browse among the available views of this cell. After
changes always doView > UpdateandFile > Save.

Always open a schematic with a configuration file by selecting the config view
followed byOpen in the pup-up menu. Then both theHierarchy-Editor and the
schematic editor will appear.

6.3.4 Simulation from the Configuration File

Start the simulation environment from theCIW window with the commandTools
> Mixed Signal Environment > Simulation. In theAnalog Artist window doSetup
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> Designand chose the correct design. Make sure that the config view is selected.
Simulate as in chapter 5.



Chapter 7

Floorplan

Texten i det här kapitlet avhandlar de steg och moment som utgör place och route
med verktygen Block- och Cell Ensemble. Informationen till kapitlet är tagen ur
Preview Fundamentals Reference, Preview Block Ensemble ReferenceochPreview
Cell Ensemble.

7.1 Object Selection Window and Layer Visibility Win-
dow

Varje gång Block Ensemble startas kommer det upp ett fönster som kallasObject
Selection Window(OSW). I detta fönster väljer man vilken eller vilka objekttyper
man vill arbeta med. För att en funktion skall kunna appliceras på objekten måste
objekttypen vara markerad i fältet i OSW.

Att markera objekt av olika slag i designfönstrets arbetsyta sker på samma vis som
med övriga verktyg, eller genom att använda sig av ett mycket användbart kom-
mando som kallasSelect Byoch som finns underEdit > Select. Select By > Name
resulterar i ett formulär som kallasSelect Instances by Name. Om man vill mark-
era en speciell instans skallinstancei fältet Which Name vara ifyllt och om man
tex vill markera alla block av en specifik sort markerasmaster. Namnet skrivs i
Name Pattern-fältet. Designfönstret visar master-namnet som default-värde. För
att kunna se instansnamnet skall kommandotDesign > Options > Displayi de-
signfönstret väljas. I formuläretDisplay Options skall det ståShow Name Of
instance. Select By > Connected tomarkerar alla andra objekt som är anslutna till
det i designfönstret redan markerade objektet (förutsatt att objekt-typerna är mark-
erad i OSW). För att tex välja GND-nätet, klicka på en GND-padd och väljSelect
By > Connected to.
Om man vill göra olika lager osynliga skall man använda sig avLayer Visibility

50
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Window, som kommer upp på skärmen genom kommandotDesign) Options)
Layer Visibility. Ett osynligt lager kan dock fortfarande selekteras.
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7.2 Arbetsflöde

Bottom - Up Top - Down
Skapa Design Hierarkin

Toppnivå schematic

Förberedelse av data

Verifiering av design

Utplacering av block
och paddar

på lägre nivå ?

Place & Route
på toppnivå

Nej

Place & Route

Skifta vy på topp-nivå
abstract layout

Ja

Toppnivå 
autoLayout

Initialisering av toppnivå

Skapa layout på topp-nivå

Kompaktering av design

Optimering av soft block
på toppnivå

Route av sub-block

Optimera soft-block

Fler sub-block ?

Nej

Ja

Skapa blockabstrakt

Skapa blocklayout

Verifiering av sub-block

Kompaktera sub-block

Place av sub-block

Skifta sub-blockens vy
autoAbstract abstract

Sub-block
autoLayout autoAbstract

Eventuell
initialisering av toppnivån

Initialisering av sub-block

Figure 7.1: Flödesschema för place och route med Block Ensemble. De olika
konstruktionsmetodernaTop-DownochBottom-Uphar också markerats i figuren.

Av flödesschemat i figur 7.1 framgår det att man kan arbeta på två sätt när man
utför place och route i Block Ensemble.Bottom-Up innebär att jobba sig up-
påt i hierarkin tills man nått toppnivån. Detta arbetssätt kräver att underliggande
nivåer måste vara implementerade.Top-Downdäremot kräver inga färdiga under-
nivåer, utan blocken realiseras somSoft Block. Ett soft block har en fix yta men
bredd/höjd-förhållandet är variabelt och utplaceringen avpinspå dess kanter kan
ändras efter behov. Etthard blockhar däremot fasta mått. Att arbeta med soft
block innebär att man på ett tidigt stadium kan optimera storlek och utplacering av
block, och även utplacering av pins för att få minimal ledarlängd vid route-arbetet.
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Top-Down är bäst att använda när chipstorleken är given och man behöver ta fram
gränserna för ingående blocks storlek.

Om paddarna som ingår i kretsen skall klossas (placeras ut kant mot kant) måste
dessa särbehandlas. Den behandlingen sker efter utplacering och före förbindning
på toppnivå.

7.3 Förberedelse av data

Block Ensemble kräver en schemavy av kretsen och abstrakta vyer av ingående
block. Block är en generell benämning och blocken kan vara av olika typer. Ett
byggblock är den lägsta nivån i hierarkin. Sub-block består av byggblock och/eller
sub-block på lägre nivå. En abstrakt vy innehåller endast information om block-
storlek och om blockets pins (antal, storlek, typ och läge). Den innehåller inga
logiska kopplingsdata. Under floor-plan arbetet använder man sig av blockens
abstrakta vyer för utplacering och sammankoppling. När arbetet är slutfört skif-
tar man blockens vy från abstrakt till fysisk. Man får skapa abstrakta vyer till
byggblock manuellt. Till block på toppnivå och sub-block genereras däremot en
abstrakt vy automatiskt (kallas förautoAbstract) när man skapar den fysiska de-
signhierarkin.

För att skapa en abstrakt vy (kallas förabstract) av ett block med en färdig layout
skall följande uträttas:

1. Öppna ett fönster iedit-läge med aktuell cell, vyn skall varalayout.

2. Skapa en box i lagerprBndry dgoch låt den fullständigt innesluta konstruk-
tionen. Om lagret inte är synligt så plocka fram det med kommandotEdit >
Set Valid Layersi LSW fönstret.

3. Spara ändringen genomDesign > Save.

4. Välj Tools > Abstractföljt av Abstract > Layout Prep...

5. I formuläret som dyker upp (Layout Preparation) skall fältetLibrary Info
File vara blankt. Klicka påOK .

6. Ett nytt formulär (Library Information ) kommer fram. I formuläret finns
det ett fält som kallasText Pin Layer Map . Det fältet skall vara blankt
om man använder sig avlabels(stycke 6.1.6) i layouten, annars skall inga
ändringar utföras i fältet. Klicka påOK .

7. Välj Abstract > Abgen. Skriv TECH_CUQ i fältet kallat Rules Library .
Dessutom skall fältetInsert FeedThrus vara av.
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7.4 Skapa designhierarkin

Innan man kan placera ut och sammanbinda de olika blocken som designen består
av måste den logiska vyn i form av ett schema översättas till en fysisk vy som kallas
autoLayout. AutoLayout-vyn kan vara flat (innehåller endast abstrakta vyer av
de ingående instanserna) eller hierarkisk (innehåller autoLayout-vyer av ingående
block och abstrakta vyer av ingående instanser). Om byggblocken inte har im-
plementerade layoutvyer får man skapa soft block som kommer att representera
blocken i autoLayout-vyn.

7.4.1 Starta Hierarchy Browser

1. Öppna ett fönster iedit-läge med aktuell cell på toppnivå, vyn skall vara
schematic.

2. Välj Tools > Floorplan/Schematic.

3. Välj Floorplan > Hierarchy Browser.

4. Klicka påOK i formuläret som dyker upp (Open Hierarchy Browser).

5. Hierarchy Browser-fönstret (HB) dyker upp. Toppnivån av kretsen visas.
För att kunna expandera neråt i nivåerna så peka med markören på boxen
och håll med mellersta musknappen. I menyn som dyker upp skallExpand
By Instanceväljas. Repetera tills alla nivåer syns.

7.4.2 Skapa soft block

I det här skedet skall man skapa soft block om inga layouter har realiserats. Soft
block skapas genom att:

1. Markera i HB de byggblock som skall representeras som soft block genom
att klicka på dem med vänster musknapp. Likadana block skall bara mark-
eras en gång. Blocken avmarkeras genom att klicka på dem ytterligare en
gång.

2. Välj Hierarchy > Properties > Set Master.

3. I formuläret (Set Master Properties) skall fältetAbstract Only markeras.
I fältet Area anger man blockets uppskattade area, medan man i fältenMin
Aspect Ratio respektiveMax Aspect Ratio anger de gränser inom vilket
bredd/höjd-förhållandet för blocket kan variera.
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4. Klicka påOK i formuläret. Om flera block markerats så dyker formulären
upp efter varandra. Dessa formulär skall uppdateras på samma sätt som det
första.

5. Välj Hierarchy > Generate Abstract From Symbol.

7.4.3 Skapa hierarkisk vy

Att skapa enhierarkiskvy sker genom följande moment:

1. Markera blocken som skall ingå i hierarkin genom att klicka på dem med
vänster musknapp. Byggblock behöver inte markeras. Likadana block skall
bara markeras en gång. Blocken avmarkeras genom att klicka på dem yt-
terligare en gång.

2. Välj Hierarchy > Properties > Set Master.

3. I formuläret (Set Master Properties) skall fältetAutoLayout & Abstract
vara markerat.

4. Klicka påOK i formuläretSet Master Properties. Om flera block markerats
så dyker formulären upp efter varandra.

5. Välj Hierarchy > Generate Physical Hierarchyför att skapa en autoLayout
cellvy som är kompatibel med Block Ensemble.

7.4.4 Skapa flat vy

Om man vill ha enflat vy behöver man inte markera några block utan endast utföra
Hierarchy > Generate Physical Hierarchy.

7.5 Initialisering av design

Detta moment skall göras både på toppnivå och sub-nivå. Alla autoLayout-vyer
måste initialiseras. Initialiseringen skapar en box i lagretprBoundary, tillräckligt
stor att rymma alla ingående paddar och block. Den gör även ingående objekt
applicerbara i det P&R-verktyg som används.

1. Öppna ett fönster iedit-läge med aktuell cell, vyn skall varaautoLayout.

2. Starta Block Ensemble genom att väljaTools > Floorplan/P&R > Block
Ensemble.
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3. Välj Floorplan > Reinitialize. Klicka påOK i formuläret.

4. I fönstret visasprBoundary-boxen. Till vänster om den finns de ingående
blocken, till höger finns alla ingående standard celler och ovanför boxen
finns alla I/O-objekt (eventuellt måste man zooma ut fönstret för att få med
allt).

7.6 Place av block och paddar

7.6.1 Automatisk utplacering

För att placera ut block och paddar automatiskt gör följande:

1. Välj Floorplan > Block Place. Kommandot placerar ut både block och pad-
dar.

2. Vill man placera ut paddarna separat skall man väljaFloorplan > IO Place
först.

3. Är man inte nöjd med utplaceringen kan man upprepa ovanstående för-
farande tills enacceptabel floorplan erhållits. Har man små block brukar
det räcka med en utplacering, men vid större block kan flera olika utplacer-
ingsalternativ erhållas.

4. Om man vill ha en bestämd ordning i utplaceringen av paddar får man skriva
en fil där man anger önskad ordning. I filen kan man även ange placering av
ingående block. Syntaxen till filen finns iPreview Fundamentals Reference,
appendix A. Genom att väljaFloorplan > Floorplan File > Readfår man
fram formuläretLoad Floorplan Constraints. I dess fält (Floorplan File
Name) skall man skriva in filnamnet och klicka påOK . Ett exempel på en
färdig utplaceringsfil finns i appendix A.

7.6.2 Manuell utplacering

För att kunna placera ut blocken manuellt skall man använda sig av kommandot
Edit > Move. Markera blocket och placera det på önskad plats. Om blocket skall
vändas eller roteras, använd någon av knapparnaRotate, Sidewayseller Upside-
down i formuläretMove.

7.7 Optimering av soft block

Ett soft block kan i likhet med vanliga block flyttas manuellt medmove-kommandot.
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Innan man kan flytta på blockets pins måste dessa göras “flytande”, dvs göras flyt-
tbara. När det är utfört optimerar man utplaceringen för att minimera ledarlängden
som krävs vid sammanbindningen mellan olika pins. Efter att optimeringen gjorts
skall de nya pin-positionerna uppdateras till respektive blocks autoLayout-vy.

1. Välj Floorplan > Soft Pins > Optimize/Float.

2. FältetAll/Selectedi formuläretModify Soft- Pins avgör vilka soft pins som
skall optimeras.

3. Klicka påFloat och därefter påOptimize.

Avbryt här om man bara optimerar översta nivåns pinnar.

4. Välj Floorplan > Update AutoLayouts.

5. Markera de block vars blockstorlek och pin-information skall uppdateras
från den abstrakta vyn till autoLayout-vyn och klicka påOK i formuläret
Update AutoLayouts.

7.8 Justering av paddar

En paddram består av fyra segment, två rader (övre och undre) och av två kolumner
(vänster och höger). Segmenten måste justeras så att i varje segment ligger paddar-
nas korta sida på en och samma linje. Behandlingen av paddarna sker i verktyget
Cell Ensemble.

1. Ladda in verktyget Cell Ensemble i autoLayoutvyn genomTools > Floor-
plan/P&R > Cell Ensemble.

2. Välj Place > IO Commands > Justify.I formuläretAlign IO Frame skall
man sättaPlacement Snap Gridtill teknologins minsta mått, t. ex. 0.05
(underförståttµm). Klicka påOK .

3. Om mellanrum erhålls i någon av paddsegmenten skall de ingående paddarna
markeras och därefter utför manEdit > Align Cells.

4. Om det visar sig att paddarna inte hamnar kant i kant med den omgivande
boxen i lagretprBoundary byså måste denna justeras. Välj och dra ut den.

5. Återgå till Block Ensemble genomTools > Floorplan/P&R > Block Ensem-
ble.
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7.9 Route av block och paddar

Sammankopplingen av de ingående blocken och sub-blocken görs i flera steg. Man
börjar med att routa nätet för strömförsörjning och därefter övriga ingående nät.
När sammankopplingen är utförd skall routingen optimeras genom reducering av
ledarlängder, antalet ledarböjar och ledarkorsningar samt minimering av antalet
kontakter mellan de olika ledarsegmenten. Routingen kan utföras automatiskt eller
manuellt. Ledarna som kommer att visas i arbetsfönstret är symboliska. De visar
bara vilket lager och vilken ledarbredd som routern använder för att förbinda de
olika noderna.

7.9.1 Automatisk routing

Strömförsörjning

Första momentet är strömförsörjningen.

1. Välj Route > Power > Automatic. FormuläretRoute Powerkommer upp
på skärmen. Om man väljerRouting Style: Planar, försöker routern att
hålla nätet så homogent som möjligt, dvs endast i ett lager. Den väljer då det
primära lagret. Vill man ha olika lager i horisontal- och vertikalled skall man
väljaRouting Style: Double layer. Man kan också ange ledarnas bredd för
båda lager.

2. Det finns möjlighet att ange vissa attribut hos VDD- och GND-näten, och att
ange blockens strömförbrukning så att routern kan räkna ut erforderlig bredd
i de olika ledaravsnitten. Informationen skrivs in i en specifikations-fil som
anges i fältetPower Specification Fileunder kommandotRoute > Power >
Taper. I Preview Block Ensemble Reference, appendix Bfinns syntaxen till
filen.

3. Klicka påOK .

IO nät

Finns det paddar i designen, skall de routas inbördes.

1. Välj Route > Power > IO Ring. Supply ochGround skall vara av;Selected
skall vara på. Selektera IO näten. Det gör man lätt genom att selektera alla
nät som finns längs en pads långa sida.

2. Klicka påOK .
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Övriga nät

De nät man har kvar skall routas enligt följande:

1. När resten av blocket skall anslutas kan man antingen routa alla befintliga
nät medRoute > Nets > All, eller välja ett eller flera specifika nät. Dessa nät
måste i så fall markeras. Efter att ha gjort valet väljRoute > Nets > Selected.

2. Klicka påOK .

7.9.2 Manuell routing

Med manuell routing avses att interaktivt kunna ta bort en ledare (wire) och förbinda
den på nytt, flytta på en ledare utan att ändra dess anslutningar till andra ledare eller
pins, ändra lagret som ledaren är dragen i och att kunna ändra bredden på en ledare
eller del av ledare.

Observera att den automatiska routern inte gör något med ett nät som är helt eller
delvis förbundet.

Manuell routing startas genomCreate > Wire. Kommandot routar en ledare mellan
punkter som anges. Ledaren ansluts till ett markerat nät.

1. Klicka med vänster musknapp på startpunkten (nät, pin eller ledare).

2. Fortsätt att klicka på de punkter där ledaren skall routas. Genom att klicka
med höger musknapp tar man bort den senaste punkten. När man kommit
till slutpunkten skall man dubbelklicka med vänster musknapp.

För att flytta ett markerat ledarsegment använder manEdit > Move. Ledare som
är anslutna till segmentet sträcks för att bibehålla anslutningarna. Ett ledarsegment
kan endast flyttas vinkelrät mot dess egen orientering. Om någon av segmentets
ändar är ansluten till en pin måste dessa separeras. Det sker genom kommandot
Edit > Wire > Split:

1. Klicka på linjens startpunkt.

2. Flytta på markören för att rita linjen. Man kan endast rita en vertikal linje
för att skära en horisontell ledare och vice versa. Klicka åter för att markera
linjens slutpunkt.

KommandotEdit > Wire > Change Layerändrar på route-lagret på en markerad
ledare.
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7.9.3 Borttagning av anslutningar

Är man inte nöjd med en, flera eller alla anslutningar, kan man ta bort dem med
kommandonaRoute > Delete Routing > ...

7.9.4 Kontroll av routing

När man routar manuellt, eller efter automatisk routing, kan man kolla om det finns
kortslutna nät medRoute > BE Utilities > Locate Shorted Nets, medanRoute > BE
Utilities > Locate Unrouted Connectionsvisar vilka nät som fortfarande behöver
routas. KommandotRoute > BE Utilities > Data Checkerkör en omfattande kon-
troll på hela designen.

7.9.5 Optimering

1. När routingen är slutförd väljRoute > Optimize > Res by Layer. Klicka på
OK .

2. Välj Route > Optimize > Contacts. Klicka påOK . Upprepa optimeringsför-
farandet tills det inte sker någon förändring längre.

7.10 Kompaktering

Efter att routing och optimering utförts skall blocket kompakteras. Kompaktorn
kompakterar symboliska objekt till minsta möjliga area med avseende på konstruk-
tionsregler och andra egenskaper. För att kompakteringen skall bli rätt görs en
extrahering som första steg.

1. Välj Compact > Compact > Extract. Funktionen extraherar kopplingsdata
och sparar resultatet i en ny cellvy. Den gör också en felcheck, såsom kon-
troll av oanslutna ledare. Efter att ha kört extraheringen kan man kompaktera
blocket. Klicka påOK i formuläretExtract . Ett nytt fönster med vysyEx-
tractedkommer upp på skärmen. Om det existerar fel måste dessa åtgärdas
innan man kan gå vidare. Felmeddelanden syns i CIW. För att kunna se
felen väljVerify > Markers > Explaini det nya fönstret. StängsyExtracted-
fönstret.

2. Välj Compact > Compact > Compacti autoLayout-fönstret. I formuläret
Compactor Options finns det ett fältAuto Jog. Där skallunlimited num-
ber of jogs per wire vara markerat. Enjog är en rätvinklig böj på en ledare
i Cadence-terminologi. Klicka påOK i formuläret. Kompaktorn öppnar ett
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fönster med den kompakterade cellvyn (compacted). Kompakteringen kan
upprepas tills ingen ändring av arean erhålls eller andra kriterier har upp-
fyllts.

7.11 Verifiering

Verifieringen är till för att kontrollera designen med avseende på brott mot ge-
ometriska och logiska konstruktionsregler. Konstruktionsreglerna är definierade i
teknologifilen. Symbolisk verifikation undersöker bara nivån som undersökningen
startats på. Den går ej ner i lägre nivåer och undersöker inte ingående instanser.

Om man får fel under verifikationsprocessen så finns det en felhanterare som visar,
förklarar och tar bort felsignaler. För att starta felhanteraren skallVerify > Error
Handlerutföras i BE-menyn.

1. Verktyget skall vara Block Ensemble och vyncompacted.

2. Verify > Symbolic DRCundersöker brott mot geometriska regler. Symbolisk
DRC skall endast köras efter kompaktering. Klicka påOK i formuläretRun
Symbolic DRC.

3. Verify > Symbolic ERCsöker efter brott mot elektriska konstruktionsregler.
Symbolisk ERC kan köras i vilket led som helst i Block Ensemble-flödet.
Klicka påOK i formuläretRun Symbolic ERC.

4. Verify > Symbolic LVSundersöker konsistensen mellan fysiska och logiska
nätlistor. Symbolisk LVS kan köras i vilket led som helst i Block Ensemble-
flödet. I formuläretRun Symbolic LVS ärLogical namnet på designen som
skall jämföras med layouten som genomgått P&R. Default-värdet är namnet
på vyn där funktionen startades.Physical är namnet på den design som
genomgått P&R och som skall jämföras med den logiska cellvyn. Default-
värdet är också här namnet på vyn där funktionen startades. Fyll i formuläret
(autoLayouti Logical ochcompactedi Physical) och klicka påOK .

5. Spara vyn genomDesign > Save.

7.12 Skapa blockabstrakt

Det fysiska sub-blocket måste ha en abstrakt vy för att ovanstående nivåer skall
kunna använda sig av blocket.

1. För att skapa en abstrakt måste Block Ensemble laddas in, vyn skall vara
compacted. Välj Tools > Floorplan/P&R > Block Ensemble.
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2. När Block Ensemble laddats in skall man väljaCreate > Block Abstract.
Klicka påOK i formuläretCreate Block abstract.

7.13 Skifta vy på ingående block

1. Välj Floorplan > Replace Viewi BE-menyn.

2. Markera de block vilkas vy skall bytas.

3. Fyll i önskad vy i fältetTo View Nameoch klicka påOK i formuläretRe-
place View.

7.14 Skapa blocklayout

Alla ledare som skapades under route-processen är symboliska. De skall konvert-
eras till geometriska ledare. Därefter skall de ingående blocken byta vy tilllayout.

1. Öppna ett fönster med vycompactedav aktuellt sub-block.

2. Välj Tools > Compactor. Kommandot laddar in verktygetVirtuoso Com-
pactor. Därefter skall kommandotCompact > Convert to Geometricväljas.
Det är viktigt att nivån som fönstret visar (Design > Options > Display) är
nivå 0 (Display Levels From 0 To 0).

3. Markera fältetSmash to View Level.

4. Markera fältetfill notch och klicka påOK . Ibland kan det vara mer förde-
laktigt att aktivera fältetfill gap. Varken notchar (= jack) heller gap upptäcks
av den symboliska DRCen, utan man måste köra den vanliga DRCen (Tools
> Layout > Verify > DRC) på layoutvyn.

5. Skifta de ingående blockens vy tilllayout i layoutfönstret.

6. Spara vyn genomDesign > Save.

7.15 Place&Route i Cell Ensemble

Cell Ensemble är den miljö man använder för att placera ut och förbinda instanser
av en speciell typ av block, kallatstandard cell. De färdiga celler som en kiseltil-
lverkare erbjuder sina kunder är ofta standard celler, vilket innebär att de har alla
samma höjd, medan bredden varierar. En standard cell innehållervdd och gnd
metal_1 rälsar som löper genom hela cellen i längdriktningen, medan övriga in-
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och utsignaler förbinds med metal_2 ledningar. Rälsarna är placerade vid samma
höjd i alla celler, så att cellerna kan klossas i långa rader utan att man behöver
förbindavdd och gnd inom samma rad, vilket sparar mycket yta. I och med att
cellerna är klossade, kan in- och utsignaler dras i höjdled men inte i sidled.

Man startar Cell Ensemble genom att väljaFloorplan / P&R > Cell Ensemble(
från autoLayout vyn ). Här följer en mycket kortfattad lista på de kommandon man
anropar för att placera ut och förbinda celler i Cell Ensemble. Lägg märketill att
det är möjligt att även ha andra block än standard celler i Cell Ensemble.

7.15.1 Initialisering

1. Välj Floorplan > Reinitialize.

2. Klicka påOK i formuläret.

3. I fönstret visasprBoundary-boxen. Till vänster om den finns de ingående
blocken, till höger finns alla ingående standard celler och ovanför boxen
finns alla I/O-objekt (eventuellt måste man zooma ut fönstret för att få med
allt). InomprBoundary-boxen finns en lilafärgad box, som är enregion för
utplacering av standard celler.

4. MarkeraRegion i OSW, klicka på regionen och väljEdit > Properties. I
formuläret kan man ändra på antalet rader där standard cellerna kommer att
placeras ut.

5. För små kretsar går det bra att behålla regionen som den är. För större kretsar
lönar det sig att skapa flera regioner (Create > Region) och fördela standard
cellerna bland regionerna (Create > GroupochEdit > Member > ...). Man
kan ändra på en region genom att klicka på den och sen dra på en av regio-
nens sidor eller hörn.

7.15.2 Place av block och standard celler

Block placerar man som i Block Ensemble. Standard celler placerar man enklast
med

1. Place > Automatic....

2. I formuläret skall man sättaPlacement Snap Gridtill teknologins minsta
mått, t. ex. 0.05 (underförståttµm).

3. Om det finns enfeedcell i cellbiblioteket skall man haInsert Feedthru på
och skriva cellens namn i formuläret. En feed cell är en tom, smal cell som
bara tillåter en metal_2 ledning löpa från topp till botten. Detta kan i vissa
fall underlätta förbindningen av angränsande celler.
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4. Klicka påOK .

5. Välj Analyze > Check > Region.

6. Klicka påApply . Ändra på de regioner som orsakar felmeddelanden och
klicka påApply igen. Alla regioner måste ligga inomprBoundary-boxen.
Om någon region sträcker sig utanförprBoundary-boxen, selekteraDesign
i OSW och gör boxen större. Det kan vara nödvändigt att köraPlace >
Automaticigen.

7. Välj Place > Check.... Alla tre fält skall markeras. Klicka påOK . Blir det
felmeddelanden, måste man iterera som för ovanstående moment.

8. Optimera soft pins (som i Block Ensemble).

7.15.3 Route av block och standard celler

Block och standard celler förbinds samtidigt.

1. Med kommandotRoute > Modify Net > Modify Net Propertieskan man
ändra på olika egenskaper hos ett nät, t. ex. prioritet och bredd. Man kan
också förbereda i förväg en fil som innehåller samma information och läsa
in den medRoute > Modify Net > Net Properties File. Hur en sån fil ser ut
ser man genom att väljaRoute > Modify Net > Net Properties Fileoch låta
kommandot skriva ut den fil som gäller för närvarande.

2. Regionerna skall tas bort.

3. Välj Route > Channels > Create. Klicka på OK . Kommandot varnar om
kanalerna inte kunde skapas. Detta innebär att utplaceringsområdet inte är
indelbart i kanaler (“sliceable”) och måste ändras.

4. Välj Route > Global Route > Automatic. Klicka påOK .

5. Välj Route > Detail Route > Automatic. Välj Options Compact och set
Routing Snap Grid till teknologins minsta mått ( 0.05 ).

6. Om designen skall användas som block i en högre nivå, skall man anropa
kommandotRoute > Detail Route > Strip Outer Channelsoch klicka på
OK . De kanaler som ligger vid designens gränser tas bort, så att man sparar
yta.

7. I Cell Ensemble ligger kanaler i var sin instans (till skillnad från Block En-
semble). Innan man kan generera abstract- och layoutvy måste man välja
Route > Detail Route > Explode Channels. Kanalinstanserna försvinner och
ledningarna dyker upp i designens högsta nivå.

8. Nu kan man generera abstract- och layoutvy som i Block Ensemble.
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Exempel på en Auto Block
Place-fil

; Ett exempel på utplacering av paddar med kommandot Auto Block Place.
; De absoluta koordinaterna tas lättast fram genom att titta på den
; floorplan som tagits fram automatiskt. I vänster och höger rad är den
; nedre padden referens och i den övre och undre raden är den vänstra
; padden referens. Referenspunkten är paddens nedre vänstra hörn.
; OBSERVERA att syntaxen skiljer sig från Auto Place!!

adpVersion = "4.2.1"

adpPadStatus(
;instName status origin orient relative
;
; Vänster kolumn
("|analog_in" placed (0.0 700.0) R270 nil)
("|gndleft" placed nil R270 T )
("|vddleft" placed nil R270 T )
("|referens_in" placed nil R270 T )
;
; Övre rad
("|D0" placed (700.0 2100.0) R180 nil)
("|gndtop" placed nil R180 R )
("|vddtop" placed nil R180 R )
("|D1" placed nil R180 R )
;
; Höger kolumn
("|D2" placed (2300.0 500.0) R90 nil)

65
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("|vddright" placed nil R90 T )
("|gndright" placed nil R90 T )
("|D3" placed nil R90 T )
;
; Nedre rad
("|analog_ut" placed (400.0 0.0) R0 nil)
("|vddbottom" placed nil R0 R )
("|gndbottom" placed nil R0 R )
("|D4" placed nil R0 R )
("|D5" placed nil R0 R )
) ; END adpPadStatus



Appendix B

Exempel på en Auto Place-fil

! Ett exempel på utplacering av paddar med kommandot Auto Place.
! I vänster och höger rad placerar man nerifrån och upp. I den övre
! och undre raden placerar man från vänster till höger.
! OBSERVERA att syntaxen skiljer sig från Auto Block Place!!

*PLACEMENT_CONSTRAINT

IO_TYPE: { PAD }

PAD_GROUP:
( |analog_in_0 |analog_ut_0 |gndleft |vddleft |ref_in_0
/G=LeftColumn /S=$LEFT /A /O )
!
( |D0 |analog_in_1 |gndtop |vddtop |ref_in_1 |D1
/G=TopRow /S=$TOP /A /O )
!
( |D2 |analog_ut_2 |vddright |gndright |analog_in_3
/G=RightColumn /S=$RIGHT /A /O )
!
( |analog_ut_5 |D3 |vddbottom |gndbottom |D4 |D5
/G=BottomRow /S=$BOTTOM /A /O )

*END
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